To our customers,

Old Company Name in Catalogs and Other Documents

On April 1st, 2010, NEC Electronics Corporation merged with Renesas Technology Corporation, and Renesas Electronics Corporation took over all the business of both companies. Therefore, although the old company name remains in this document, it is a valid Renesas Electronics document. We appreciate your understanding.

Renesas Electronics website: http://www.renesas.com

April 1st, 2010
Renesas Electronics Corporation

Issued by: Renesas Electronics Corporation (http://www.renesas.com)
Send any inquiries to http://www.renesas.com/inquiry.

**Notice**

1. All information included in this document is current as of the date this document is issued. Such information, however, is subject to change without any prior notice. Before purchasing or using any Renesas Electronics products listed herein, please confirm the latest product information with a Renesas Electronics sales office. Also, please pay regular and careful attention to additional and different information to be disclosed by Renesas Electronics such as that disclosed through our website.

2. Renesas Electronics does not assume any liability for infringement of patents, copyrights, or other intellectual property rights of third parties by or arising from the use of Renesas Electronics products or technical information described in this document. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics or others.

3. You should not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or in part.

4. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products and application examples. You are fully responsible for the incorporation of these circuits, software, and information in the design of your equipment. Renesas Electronics assumes no responsibility for any losses incurred by you or third parties arising from the use of these circuits, software, or information.

5. When exporting the products or technology described in this document, you should comply with the applicable export control laws and regulations and follow the procedures required by such laws and regulations. You should not use Renesas Electronics products or the technology described in this document for any purpose relating to military applications or use by the military, including but not limited to the development of weapons of mass destruction. Renesas Electronics products and technology may not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited under any applicable domestic or foreign laws or regulations.

6. Renesas Electronics has used reasonable care in preparing the information included in this document, but Renesas Electronics does not warrant that such information is error free. Renesas Electronics assumes no liability whatsoever for any damages incurred by you resulting from errors in or omissions from the information included herein.

7. Renesas Electronics products are classified according to the following three quality grades: “Standard”, “High Quality”, and “Specific”. The recommended applications for each Renesas Electronics product depend on the product’s quality grade, as indicated below. You must check the quality grade of each Renesas Electronics product before using it in a particular application. You may not use any Renesas Electronics product for any application categorized as “Specific” without the prior written consent of Renesas Electronics. Further, you may not use any Renesas Electronics product for any application for which it is not intended without the prior written consent of Renesas Electronics. Renesas Electronics shall not be in any way liable for any damages or losses incurred by you or third parties arising from the use of any Renesas Electronics product for an application categorized as “Specific” or for which the product is not intended where you have failed to obtain the prior written consent of Renesas Electronics. The quality grade of each Renesas Electronics product is “Standard” unless otherwise expressly specified in a Renesas Electronics data sheets or data books, etc.

- **“Standard”:** Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home electronic appliances; machine tools; personal electronic equipment; and industrial robots.
- **“High Quality”:** Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster systems; anti-crime systems; safety equipment; and medical equipment not specifically designed for life support.
- **“Specific”:** Aircraft; aerospace equipment; submersible repeaters; nuclear reactor control systems; medical equipment or systems for life support (e.g. artificial life support devices or systems), surgical implantations, or healthcare intervention (e.g. excision, etc.), and any other applications or purposes that pose a direct threat to human life.

8. You should use the Renesas Electronics products described in this document within the range specified by Renesas Electronics, especially with respect to the maximum rating, operating supply voltage range, movement power voltage range, heat radiation characteristics, installation and other product characteristics. Renesas Electronics shall have no liability for malfunctions or damages arising out of the use of Renesas Electronics products beyond such specified ranges.

9. Although Renesas Electronics endeavors to improve the quality and reliability of its products, semiconductor products have specific characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Further, Renesas Electronics products are not subject to radiation resistance design. Please be sure to implement safety measures to guard them against the possibility of physical injury, and injury or damage caused by fire in the event of the failure of a Renesas Electronics product, such as safety design for hardware and software including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult, please evaluate the safety of the final products or system manufactured by you.

10. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas Electronics product. Please use Renesas Electronics products in compliance with all applicable laws and regulations that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS Directive. Renesas Electronics assumes no liability for damages or losses occurring as a result of your noncompliance with applicable laws and regulations.

11. This document may not be reproduced or duplicated, in any form, in whole or in part, without prior written consent of Renesas Electronics.

12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas Electronics products, or if you have any other inquiries.

(Note 1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its majority-owned subsidiaries.

(Note 2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.
Notes regarding these materials

1. This document is provided for reference purposes only so that Renesas customers may select the appropriate Renesas products for their use. Renesas neither makes warranties or representations with respect to the accuracy or completeness of the information contained in this document nor grants any license to any intellectual property rights or any other rights of Renesas or any third party with respect to the information in this document.

2. Renesas shall have no liability for damages or infringement of any intellectual property or other rights arising out of the use of any information in this document, including, but not limited to, product data, diagrams, charts, programs, algorithms, and application circuit examples.

3. You should not use the products or the technology described in this document for the purpose of military applications such as the development of weapons of mass destruction or for the purpose of any other military use. When exporting the products or technology described herein, you should follow the applicable export control laws and regulations, and procedures required by such laws and regulations.

4. All information included in this document such as product data, diagrams, charts, programs, algorithms, and application circuit examples, is current as of the date this document is issued. Such information, however, is subject to change without any prior notice. Before purchasing or using any Renesas products listed in this document, please confirm the latest product information with a Renesas sales office. Also, please pay regular and careful attention to additional and different information to be disclosed by Renesas such as that disclosed through our website. (http://www.renesas.com)

5. Renesas has used reasonable care in compiling the information included in this document, but Renesas assumes no liability whatsoever for any damages incurred as a result of errors or omissions in the information included in this document.

6. When using or otherwise relying on the information in this document, you should evaluate the information in light of the total system before deciding about the applicability of such information to the intended application. Renesas makes no representations, warranties or guarantees regarding the suitability of its products for any particular application and specifically disclaims any liability arising out of the application and use of the information in this document or Renesas products.

7. With the exception of products specified by Renesas as suitable for automobile applications, Renesas products are not designed, manufactured or tested for applications or otherwise in systems the failure or malfunction of which may cause a direct threat to human life or create a risk of human injury or which require especially high quality and reliability such as safety systems, or equipment or systems for transportation and traffic, healthcare, combustion control, aerospace and aeronautics, nuclear power, or underwater communication transmission. If you are considering the use of our products for such purposes, please contact a Renesas sales office beforehand. Renesas shall have no liability for damages arising out of the uses set forth above.

8. Notwithstanding the preceding paragraph, you should not use Renesas products for the purposes listed below:
   (1) artificial life support devices or systems
   (2) surgical implantations
   (3) healthcare intervention (e.g., excision, administration of medication, etc.)
   (4) any other purposes that pose a direct threat to human life

Renesas shall have no liability for damages arising out of the uses set forth in the above and purchasers who elect to use Renesas products in any of the foregoing applications shall indemnify and hold harmless Renesas Technology Corp., its affiliated companies and their officers, directors, and employees against any and all damages arising out of such applications.

9. You should use the products described herein within the range specified by Renesas, especially with respect to the maximum rating, operating supply voltage range, movement power voltage range, heat radiation characteristics, installation and other product characteristics. Renesas shall have no liability for malfunctions or damages arising out of the use of Renesas products beyond such specified ranges.

10. Although Renesas endeavors to improve the quality and reliability of its products, IC products have specific characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Please be sure to implement safety measures to guard against the possibility of physical injury, and injury or damage caused by fire in the event of the failure of a Renesas product, such as safety design for hardware and software including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for aging degradation or any other applicable measures. Among others, since the evaluation of microcomputer software alone is very difficult, please evaluate the safety of the final products or system manufactured by you.

11. In case Renesas products listed in this document are detached from the products to which the Renesas products are attached or affixed, the risk of accident such as swallowing by infants and small children is very high. You should implement safety measures so that Renesas products may not be easily detached from your products. Renesas shall have no liability for damages arising out of such detachment.

12. This document may not be reproduced or duplicated, in any form, in whole or in part, without prior written approval from Renesas.

13. Please contact a Renesas sales office if you have any questions regarding the information contained in this document, Renesas semiconductor products, or if you have any other inquiries.
Trademarks

Microsoft, MS-DOS, Windows, Windows NT are registered trademarks of Microsoft Corporation.
Visual SourceSafe is a trademark of Microsoft Corporation.
IBM is a registered trademark of International Business Machines Corporation.
All brand or product names used in this manual are trademarks or registered trademarks of their respective companies or organizations.

Document Information

Product Code: S32HEWM
Version:

Copyright © Renesas Technology Corp. 2003. All rights reserved.
About This Manual

This manual describes the HEW system. This manual is composed of two parts. HEW part describes information on the basic “look and feel” of the HEW and customizing the HEW environment and detail the build. Figure in the HEW part are those of the SH series. Simulator/Debugger part describes Debugger functions of the High-performance Embedded Workshop.

This manual does not intend to explain how to write C/C++ or assembly language programs, how to use any particular operating system or how best to tailor code for the individual devices. These issues are left to the respective manuals.

Document Conventions

This manual uses the following typographic conventions:

<table>
<thead>
<tr>
<th>Table 1 Typographic Conventions</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Convention</strong></td>
</tr>
<tr>
<td>[Menu-&gt;Menu Option]</td>
</tr>
<tr>
<td>FILENAME.C</td>
</tr>
<tr>
<td>“enter this string”</td>
</tr>
<tr>
<td>Key + Key</td>
</tr>
<tr>
<td>(The “how to” symbol)</td>
</tr>
</tbody>
</table>
Contents

Section 1  Overview .................................................................................................................. 1

Section 2  Simulator/Debugger Functions ................................................................................. 3
  2.1  Features ............................................................................................................................ 3
  2.2  Target User Program ....................................................................................................... 4
  2.3  Simulation Range ............................................................................................................. 4
  2.4  Memory Management ....................................................................................................... 5
  2.5  Instruction-Execution Reset Processing .......................................................................... 6
  2.6  Exception Processing ....................................................................................................... 7
  2.7  H8S/2000 CPU Specific Functions ................................................................................ 8
  2.8  H8S/2600 CPU Specific Functions ................................................................................ 9
  2.9  H8SX Series CPU Specific Functions .......................................................................... 10
  2.10 Control Registers .......................................................................................................... 10
  2.11 Timer (H8S Series and H8SX Series) .......................................................................... 11
      2.11.1 Supported Range .................................................................................................... 11
      2.11.2 Control Registers .................................................................................................. 11
      2.11.3 Clocks ................................................................................................................... 12
      2.11.4 Using a Timer ....................................................................................................... 12
      2.11.5 Notes on Using a Timer ....................................................................................... 12
  2.12 Trace .................................................................................................................................... 12
  2.13 Standard I/O and File I/O Processing ............................................................................. 13
  2.14 Calculation of the Number of Instruction Execution Cycles .......................................... 15
  2.15 Break Conditions .......................................................................................................... 16
  2.16 Floating-Point Data ....................................................................................................... 21
  2.17 Display of Function Call History .................................................................................. 21
  2.18 Performance Measurement ............................................................................................ 22
      2.18.1 Profiler .................................................................................................................. 22
      2.18.2 Performance Analysis .......................................................................................... 22
  2.19 Pseudo-Interrupts ......................................................................................................... 23
  2.20 Coverage ........................................................................................................................ 24

Section 3  Debugging ................................................................................................................. 25
  3.1  Creating the Workspace for Simulator/Debugger .......................................................... 26
      3.1.1 Selecting a Debugging Platform ........................................................................... 26
      3.1.2 Setting up a Workspace for the Simulator/Debugger ........................................... 27
  3.2  Modifying the Simulator/Debugger Settings .................................................................... 29
3.2.1 Modifying the Simulator System ................................................................. 29
3.2.2 Modifying the Memory Map and Memory Resource Settings ................... 31
3.2.3 Set Memory Map Dialog Box ...................................................................... 33
3.2.4 Set Memory Resource Dialog Box .............................................................. 35
3.3 Simulating Peripheral Functions .................................................................... 36
  3.3.1 Registering Peripheral Function Simulation Modules ................................. 36
  3.3.2 Changing the Addresses of Peripheral Functions ....................................... 38
  3.3.3 Changing the Interrupt Source Information of Peripheral Functions ......... 40
  3.3.4 Allocating Memory Resources to the Interrupt Priority Register .............. 42
  3.3.5 Viewing the Names of Connected Peripheral Functions ......................... 42
3.4 Using the Simulator/Debugger Breakpoints .................................................... 42
  3.4.1 Listing the Breakpoints ............................................................................. 42
  3.4.2 Setting a Breakpoint .................................................................................. 44
  3.4.3 Modifying Breakpoints ............................................................................. 54
  3.4.4 Enabling a Breakpoint ............................................................................... 54
  3.4.5 Disabling a Breakpoint ............................................................................... 54
  3.4.6 Deleting a Breakpoint ............................................................................... 54
  3.4.7 Deleting All Breakpoints .......................................................................... 54
  3.4.8 Viewing the Source Line for a Breakpoint ............................................... 55
  3.4.9 Closing Input or Output File ....................................................................... 55
  3.4.10 Closing All Input and Output Files .......................................................... 55
3.5 Viewing Trace Information ............................................................................. 56
  3.5.1 Opening the Trace Window ....................................................................... 56
  3.5.2 Specifying Trace Acquisition Conditions ............................................... 56
  3.5.3 Acquiring Trace Information ..................................................................... 58
  3.5.4 Searching for a Trace Record .................................................................... 59
  3.5.5 Clearing the Trace Information ................................................................. 60
  3.5.6 Saving the Trace Information in a File .................................................... 60
  3.5.7 Viewing the Source File .......................................................................... 60
  3.5.8 Trimming the Source .............................................................................. 60
  3.5.9 Analyzing Statistical Information ............................................................ 61
3.6 Viewing the Profile Information ................................................................. 63
  3.6.1 Stack Information Files ........................................................................... 63
  3.6.2 Profile Information Files .......................................................................... 65
  3.6.3 Loading Stack Information Files ............................................................... 67
  3.6.4 Enabling the Profile .................................................................................. 69
  3.6.5 Specifying Measurement Mode ............................................................... 69
  3.6.6 Executing the Program and Checking the Results ................................... 69
  3.6.7 List Sheet .................................................................................................. 70
  3.6.8 Tree Sheet ................................................................................................ 71
3.11.5 Creating Fixed Text ............................................................................................. 112
3.11.6 Changing the Size and Position of an Item ......................................................... 114
3.11.7 Copying an Item .................................................................................................. 114
3.11.8 Deleting an Item .................................................................................................. 114
3.11.9 Showing the Grid ................................................................................................. 115
3.11.10 Saving I/O Panel Information ............................................................................ 115
3.11.11 Loading I/O Panel Information ........................................................................... 115

Section 4   Windows............................................................................................117

Section 5   Command Lines.....................................................................................119
5.1 Commands (Functional Order) ................................................................................. 119
      5.1.1 Execution ..................................................................................................... 119
      5.1.2 Download .................................................................................................... 120
      5.1.3 Register ....................................................................................................... 120
      5.1.4 Memory ....................................................................................................... 121
      5.1.5 Assemble/Disassemble ............................................................................... 121
      5.1.6 Break .......................................................................................................... 122
      5.1.7 Trace .......................................................................................................... 122
      5.1.8 Coverage ..................................................................................................... 123
      5.1.9 Performance ............................................................................................... 123
      5.1.10 Watch ....................................................................................................... 123
      5.1.11 Script/Logging ........................................................................................... 124
      5.1.12 Memory Resource ..................................................................................... 124
      5.1.13 Simulator/Debugger Settings ...................................................................... 124
      5.1.14 Standard I/O and File I/O ....................................................................... 125
      5.1.15 Utility ........................................................................................................ 125
      5.1.16 Project/Workspace .................................................................................. 126
      5.1.17 Test Tool Facility ...................................................................................... 126
5.2 Commands (Alphabetical Order) ............................................................................. 127

Section 6   Messages ............................................................................................133
6.1 Information Messages ............................................................................................. 133
6.2 Error Messages ....................................................................................................... 134

Section 7   Tutorial ............................................................................................137
7.1 Preparation ...................................................................................................... 137
      7.1.1 Sample Program ....................................................................................... 137
      7.1.2 Creating the Sample Program .................................................................... 137
7.2 Settings for Debugging .................................................................................... 138
Section 1  Overview

The simulator/debugger is a powerful development environment tool for embedded applications running on Renesas Technology microcomputers.

The simulator/debugger is used with the High-performance Embedded Workshop (HEW). The HEW provides a graphical user interface that eases the development and debugging of applications written in the C/C++ programming languages or assembly language for Renesas Technology microcomputers. Its aim is to provide a powerful yet intuitive way of accessing, observing and modifying the debugging platform on which the application is running.

READ the simulator/debugger and HEW help information before using the simulator/debugger.
Section 2   Simulator/Debugger Functions

This section describes the functions of the H8S, H8/300 series simulator/debugger.

2.1 Features

- Since the simulator/debugger runs on a host computer, software debugging can start without using an actual user system, thus reducing overall system development time.
- The simulator/debugger performs a simulation to calculate the number of instruction execution cycles for a program, thus enabling performance evaluation without using an actual user system.
- The simulator/debugger provides pseudo-interrupt and I/O-simulation functions for simple system-level simulation.
- The simulator/debugger offers the following functions that enable efficient program testing and debugging:
  - The ability to handle all of the H8S, H8/300 series CPUs
  - Functions to stop or continue execution when an error occurs during user program execution
  - Profile data acquisition and function-unit performance measurement
  - A comprehensive set of break functions
  - Functions to set or edit memory maps
  - Functions to display function call history
  - Coverage information is displayed in the C/C++ or assembly-source level
  - Visual debugging functions provided through the display of images or waveforms
- The breakpoints, memory map, performance, and trace can be set through the dialog boxes under Windows®. Environments corresponding to each memory map of the H8S, H8/300 series microcomputers can be set through the dialog box.
  - Intuitive user interface
  - Online help
  - Common display and operability
2.2 Target User Program

Load modules in the Elf/Dwarf2 format can be symbolically debugged with the simulator/debugger. Load modules in other formats can be downloaded, and their instructions can be executed; however, they cannot be symbolically debugged. For details, refer to section 17.18.2, Elf/Dwarf2 Support in the High-performance Embedded Workshop V.4.03 User’s Manual.

2.3 Simulation Range


The simulator/debugger supports the following H8S, H8/300 series microcomputer functions:

- All CPU instructions
- Exception processing
- Registers
- All address space
- CPU modes shown in table 2.1

Table 2.1 Platforms and CPU Modes

<table>
<thead>
<tr>
<th>Names of Debugging Platforms</th>
<th>CPU Modes</th>
</tr>
</thead>
<tbody>
<tr>
<td>H8/300 Simulator</td>
<td>H8/300</td>
</tr>
<tr>
<td>H8/300L Simulator</td>
<td>H8/300L</td>
</tr>
<tr>
<td>H8/300HA Simulator</td>
<td>H8/300H: advanced mode</td>
</tr>
<tr>
<td>H8/300HN Simulator</td>
<td>H8/300H: normal mode</td>
</tr>
<tr>
<td>H8S/2600A Simulator</td>
<td>H8S/2600: advanced mode</td>
</tr>
<tr>
<td>H8S/2600N Simulator</td>
<td>H8S/2600: normal mode</td>
</tr>
<tr>
<td>H8SX Normal Simulator</td>
<td>H8SX: normal mode</td>
</tr>
<tr>
<td>H8SX Advanced Simulator</td>
<td>H8SX: advanced mode</td>
</tr>
<tr>
<td>H8SX Maximum Simulator</td>
<td>H8SX: maximum mode</td>
</tr>
</tbody>
</table>
The simulator/debugger does not support the following H8S, H8/300 series MCU functions. Programs that use these functions must be debugged with the H8S, H8/300 series emulator.

- Dual-port RAM
- Timer (Not supported in the H8/300 series only)
- Pulse-width modular
- Serial communication interface (SCI)
- A/D converter
- I/O ports
- Interrupt controller

2.4 Memory Management

**Memory Map Specification:** A memory map is used to calculate the number of memory access cycles during simulation. The following items can be specified:

- Memory type
- Start and end addresses of the memory area
- Number of memory access cycles
- Memory data bus width

For details, refer to section 3.2.2, Modifying the Memory Map and Memory Resource Settings. The user program can be executed in all areas except for the internal I/O area.

**Memory Resource Specification:** A memory resource must be specified to load and execute a user program. The following items can be specified:

- Start address
- End address
- Access type

The access type is readable/writable, read-only, or write-only.

Since an error occurs if the user program attempts an illegal access (for example, trying to write to read-only memory), such an illegal access in the user program can be easily detected.

Unlike the other memory, EEPROM is writable by the EEPMOV instruction even if its access type is read-only. Other instructions than EEPMOV are not available.
For details on memory resource setting, refer to section 3.2.2, Modifying the Memory Map and Memory Resource Settings.

2.5 Instruction-Execution Reset Processing

The simulator/debugger resets the instruction execution counts and the number of instruction execution cycles when:

- The program counter (PC) is modified after the instruction simulation stops and before it restarts.
- The Run command to which the execution start address has been specified is executed.
- Initialization is performed or the program is loaded.
2.6 Exception Processing

The simulator/debugger detects the generation of TRAPA instructions (H8/300H, H8S, and H8SX series only) and trace exceptions (H8S and H8SX series only) and simulates exception processing. Accordingly, simulation can be performed even when an exception occurs.

The simulator/debugger simulates exception processing with the following procedures.

1. Detects an exception during instruction execution.
2. Saves the PC and CCR in the stack area. EXR is also saved when the enabled bit of EXR is on. If an error occurs when saving, the simulator/debugger stops exception processing, shows that the exception processing error has occurred, and returns to the command input wait state.
3. Sets the I bit in CCR to 1.
4. Reads the start address from the vector address corresponding to the vector number. If an error occurs when reading, the simulator/debugger stops exception processing, shows that the exception processing error has occurred, and returns to the command input wait state.
5. Starts instruction execution from the start address. If the start address is 0, the simulator/debugger stops exception processing, shows that the exception processing error has occurred, and returns to the command input wait state.
2.7 H8S/2000 CPU Specific Functions

The H8S/2000-series simulator/debugger supports interrupt modes. Use the bits INTM1 and INTM0 in SYSCR to set the interrupt modes. Note that SYSCR only supports INTM1 and INTM0. The initial value of the SYSCR address is H’FF39, and this value can be changed by changing the [SYSCR Address] field in the [Simulator System] dialog box. The changed address value is saved in the session file.

The simulator/debugger supports interrupt modes 0, 1, and 2, though the availability of interrupt modes depends on the CPU in use.

The control levels for event-driven interrupts vary as follows:

- If [Interrupt] is selected and [Priority] is 0 in the [Action type] field of the [Select Break Type] dialog box, the control level is 0.
- If [Interrupt] is selected and [Priority] is not 0 in the [Action type] field of the [Select Break Type] dialog box, the control level is 1.
2.8  **H8S/2600 CPU Specific Functions**

**MAC Instruction:** The multiplication/accumulation operation (MAC instruction) can be performed on the H8S/2600 CPU. In this instruction, a saturation and non-saturation operations are selectable. The simulator/debugger determines the operation with a value of bit 7 (hereafter called as the MACS bit) in the SYSCR register of internal I/O.

MACS bit 0: Non-saturation operation  
MACS bit 1: Saturation operation

**EXR Register:** The EXR register can be used on the H8S/2600 CPU. It is also possible to set the enable or disable state of this register. The simulator/debugger determines the operation with a value of bit 5 (hereafter called as the EXR bit) in the SYSCR register of internal I/O.

EXR bit 0: EXR disabled  
EXR bit 1: EXR enabled

The SYSCR address is set in [SYSCR Address] in the [Simulator System] dialog box.

Note: Set the SYSCR address in the internal I/O. Note that the simulator/debugger determines the MACS bit as 0 (non-saturation) and the EXR bit as 0 (EXR disabled) when the SYSCR address is set other than the internal I/O.

For details, refer to section 3.2.1, Modifying the Simulator System.
2.9 H8SX Series CPU Specific Functions

Enabling/Disabling the Multiplier/Divider: The user can enable or disable the multiplier or the divider. This allows the user to check the difference in performance of the program in cases where the multiplier or the divider is used or not. To enable or disable the multiplier or the divider, check or uncheck [Multiplier] or [Divider] in the [Simulator System] dialog box, respectively.

Fetch Mode: A 16-bit or 32-bit fetch can be selected. This allows the user to check the difference in performance of the program with different fetch sizes. The fetch mode can be selected by setting of bit FETCHMD in the SYSCR register.

Endian: The endian can be specified by using the ENDIANCR register only when the current MCU mode is the advanced or maximum mode and the size of the address area is 16 Mbytes or 256 Mbytes. The byte order of little endian is also supported as the format to save data on memory, as well as that of big endian. This allows user programs created with little endian to be simulated and debugged.

Interrupt Control Mode Selection: Only bit INTM1 of the interrupt control register (INTCR) is supported. This bit allows selection of the interrupt control mode.

2.10 Control Registers

The H8S/2600 series and H8SX series simulators/debuggers support the SYSCR (system control register) as the control register mapped to the memory. It enables multiplication/accumulation operation, user program simulation for EXR accessing, and debugging.

The SYSCR address is set in [SYSCR Address] in the [Simulator System] dialog box. For modifying or displaying the control register, use the [IO] window.

For details, refer to section 3.2.1, Modifying the Simulator System in this document, or section 17.6, Looking at I/O Memory, in the High-performance Embedded Workshop V.4.03 User’s Manual.
2.11 Timer (H8S Series and H8SX Series)

2.11.1 Supported Range

The H8S and H8SX series simulator/debugger supports channel 0 of 16-bit timer pulse unit 0. This simulator/debugger only supports interrupts by an overflow or a compare match, not a function with an input to or output from pins such as the input capture function.

2.11.2 Control Registers

This simulator/debugger supports timer registers. Table 2.2 shows the control registers supported by the simulator/debugger.

The addresses of the timer control registers, interrupt vector numbers, and positions of the interrupt priority registers can be changed in the [Peripheral Module Configuration] dialog box. For details on the [Peripheral Module Configuration] dialog box, refer to section 3.3, Simulating Peripheral Functions.

Table 2.2 Timer Control Registers Supported by the Simulator/Debugger

<table>
<thead>
<tr>
<th>Timer</th>
<th>Supported Control Register</th>
<th>Support</th>
</tr>
</thead>
<tbody>
<tr>
<td>TPU0</td>
<td>TSTR</td>
<td>△</td>
</tr>
<tr>
<td></td>
<td>TCR</td>
<td>△</td>
</tr>
<tr>
<td></td>
<td>TIER</td>
<td>O</td>
</tr>
<tr>
<td></td>
<td>TSR</td>
<td>O</td>
</tr>
<tr>
<td></td>
<td>TCNT</td>
<td>O</td>
</tr>
<tr>
<td></td>
<td>TGRA</td>
<td>O</td>
</tr>
<tr>
<td></td>
<td>TGRB</td>
<td>O</td>
</tr>
<tr>
<td></td>
<td>TGRC</td>
<td>O</td>
</tr>
<tr>
<td></td>
<td>TGRD</td>
<td>O</td>
</tr>
</tbody>
</table>

Note: O: Supported
△: Partly supported (bits for the function described in section 2.11.1, Supported Range)
2.11.3 Clocks

The simulator/debugger supports an internal clock that provides timing in access to memory, a peripheral function clock, and clocks for operating the timers.

The numbers of cycles of the internal clock required for access to memory correspond to the specifications for the memory map. Set the frequency ratio of the internal clock to the peripheral function clock in the [Set Peripheral Function Simulation] dialog box.

Use the timer control register to specify the division ratio to create the clock for operating the timers.

2.11.4 Using a Timer

To use a timer, the timer module must be registered in the [Set Peripheral Function Simulation] dialog box, which is opened at initiation of the simulator/debugger.

For details on the timer module registration, refer to section 3.3, Simulating Peripheral Functions.

2.11.5 Notes on Using a Timer

1. Even if the actual CPU can only clear a bit to 0, the simulator can write 1 to this bit.
2. The user can select whether or not to cause a break when a timer interrupt occurs. This can be set in the [Simulator System] dialog box or by the EXEC_STOP_SET command.

2.12 Trace

The simulator/debugger writes the execution results of each instruction into the trace buffer. The conditions for trace information acquisition can be specified in the [Trace Acquisition] dialog box.

Right-clicking on the [Trace] window displays the pop-up menu. Choose [Acquisition...] from the pop-up menu to display the [Trace Acquisition] dialog box. The acquired trace information is displayed in the [Trace] window.

The trace information can be searched. The search conditions can be specified in the [Trace Search] dialog box. Right-clicking on the [Trace] window displays the pop-up menu. Choose [Find...] from the pop-up menu to display the [Trace Search] dialog box.

For details, refer to section 3.5, Viewing Trace Information.
2.13 Standard I/O and File I/O Processing

The simulator/debugger enables the standard I/O and file I/O processing listed in table 2.4 to be executed by the user program. When the I/O processing is executed, the [Simulated I/O] window must be open.

Table 2.3 shows the supported I/O functions. The function codes have 16-bit address, 24-bit address, and 32-bit address versions. Select the version suitable for the CPU being used.
### Table 2.3 I/O Functions

<table>
<thead>
<tr>
<th>No.</th>
<th>Function Code</th>
<th>Function Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>H’01 (16-bit address)</td>
<td>GETC</td>
<td>Inputs one byte from the standard input</td>
</tr>
<tr>
<td></td>
<td>H’11 (24-bit address)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>H’21 (32-bit address)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>H’02 (16-bit address)</td>
<td>PUTC</td>
<td>Outputs one byte to the standard output</td>
</tr>
<tr>
<td></td>
<td>H’12 (24-bit address)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>H’22 (32-bit address)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>H’03 (16-bit address)</td>
<td>GETS</td>
<td>Inputs one line from the standard input</td>
</tr>
<tr>
<td></td>
<td>H’13 (24-bit address)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>H’23 (32-bit address)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>H’04 (16-bit address)</td>
<td>PUTS</td>
<td>Outputs one line to the standard output</td>
</tr>
<tr>
<td></td>
<td>H’14 (24-bit address)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>H’24 (32-bit address)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>H’05 (16-bit address)</td>
<td>FOPEN</td>
<td>Opens a file</td>
</tr>
<tr>
<td></td>
<td>H’15 (24-bit address)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>H’25 (32-bit address)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>H’06</td>
<td>FCLOSE</td>
<td>Closes a file</td>
</tr>
<tr>
<td>7</td>
<td>H’07 (16-bit address)</td>
<td>FGETC</td>
<td>Inputs one byte from a file</td>
</tr>
<tr>
<td></td>
<td>H’17 (24-bit address)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>H’27 (32-bit address)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>H’08 (16-bit address)</td>
<td>FPUTC</td>
<td>Outputs one byte to a file</td>
</tr>
<tr>
<td></td>
<td>H’18 (24-bit address)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>H’28 (32-bit address)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>H’09 (16-bit address)</td>
<td>FGETS</td>
<td>Inputs one line from a file</td>
</tr>
<tr>
<td></td>
<td>H’19 (24-bit address)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>H’29 (32-bit address)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>H’0A (16-bit address)</td>
<td>FPUTS</td>
<td>Outputs one line to a file</td>
</tr>
<tr>
<td></td>
<td>H’1A (24-bit address)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>H’2A (32-bit address)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>H’0B</td>
<td>FEOF</td>
<td>Checks for end of the file</td>
</tr>
<tr>
<td>12</td>
<td>H’0C</td>
<td>FSEEK</td>
<td>Moves the file pointer</td>
</tr>
<tr>
<td>13</td>
<td>H’0D</td>
<td>FTELL</td>
<td>Returns the current position of the file pointer</td>
</tr>
</tbody>
</table>

For details on I/O functions, refer to section 3.10, Standard I/O and File I/O Processing.
2.14 Calculation of the Number of Instruction Execution Cycles

The simulator/debugger calculates the number of instruction execution cycles by using the expression, the data-bus width of the memory map, and the number of access cycles, which is described in the H8S, H8/300 Series Software Manual. However, note that the number of instruction execution cycles that is calculated on the simulator/debugger may differ from the one when the program is executed on the system.

**MOVFPE and MOVTPE Instructions**: The number of cycles for transferring data of the E-clock synchronization instruction is the value between 9 and 16. The simulator/debugger calculates as ‘11 + number of operand access cycles’. The number of operand access cycles can be calculated from the data bus width of the memory and the number of access cycles.

**EEPMOV Instruction**: The number of cycles for the EEPROM-write instruction is the sum of the number of cycles for reading instructions and cycles for transferring data.

**SLEEP Instruction**: The simulator/debugger does not add the number of cycles considering the case when the SLEEP instruction is used for halting program.

**Standard I/O and file I/O processing**: The standard I/O and file I/O processing are specific functions for the simulator/debugger, and they are not added to the number of cycles. Note that the standard I/O and file I/O processing are the period while the branch to the position specified with the simulated I/O address of the BSR and JSR instructions is completed to return to the caller address after the I/O processing.
2.15 Break Conditions

The simulator/debugger provides the following conditions for interrupting the simulation of a user program during execution.

- Break due to the satisfaction of a break command condition
- Break due to the detection of an error during execution of the user program
- Break due to a trace buffer overflow
- Break due to execution of the SLEEP instruction
- Break due to the [STOP] button

**Break Due to Satisfaction of a Break Command Condition:** There are five break commands as follows:

- BREAKPOINT: Break based on the address of the instruction executed
- BREAK_ACCESS: Break based on access to a memory range
- BREAK_CYCLE: Break based on the instruction execution cycles
- BREAK_DATA: Break based on the value of data written to memory
- BREAK_REGISTER: Break based on the value of data written to a register
- BREAK_SEQUENCE: Break based on a specified execution sequence

If [Stop] is specified as the action to take when a break condition is satisfied, user program execution stops when the break condition is satisfied. For details, refer to section 3.4, Using the Simulator/Debugger Breakpoints.

When a break condition is satisfied and user program execution stops, the instruction at the breakpoint may or may not be executed before a break depending on the type of break, as listed in table 2.4.
### Table 2.4 Processing When a Break Condition is Satisfied

<table>
<thead>
<tr>
<th>Command</th>
<th>Instruction When a Break Condition is Satisfied</th>
</tr>
</thead>
<tbody>
<tr>
<td>BREAKPOINT</td>
<td>Not executed</td>
</tr>
<tr>
<td>BREAK_ACCESS</td>
<td>Executed</td>
</tr>
<tr>
<td>BREAK_CYCLE</td>
<td>Executed</td>
</tr>
<tr>
<td>BREAK_DATA</td>
<td>Executed</td>
</tr>
<tr>
<td>BREAKREGISTER</td>
<td>Executed</td>
</tr>
<tr>
<td>BREAKSEQUENCE</td>
<td>Not executed</td>
</tr>
</tbody>
</table>

For BREAKPOINT and BREAK_SEQUENCE, if a breakpoint is specified at an address that is not the beginning of an instruction, the break will not be detected.

When a break condition is satisfied during user program execution, a break condition satisfaction message is displayed on the status bar and the execution stops.
**Break Due to Error Detection during User Program Execution:** The simulator/debugger detects simulation errors, that is, program errors that cannot be detected by the CPU exception generation functions. The [Simulator System] dialog box specifies whether to stop or continue the simulation when such an error occurs. Table 2.5 lists the error messages, error causes, and the action of the simulator/debugger in the continuation mode.

**Table 2.5 Simulation Errors**

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Error Cause</th>
<th>Processing in Continuation Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address Error (Address: Hnnnnnnnn)</td>
<td>Odd PC value</td>
<td>Operates in the same way as the actual device operation.</td>
</tr>
<tr>
<td></td>
<td>Instruction was fetched from the internal I/O area</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Access in words from odd-number addresses</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Access in longwords from odd-number addresses</td>
<td></td>
</tr>
<tr>
<td>Memory Access Error (ADDRESS: H'00800000)</td>
<td>Access to a memory area that has not been allocated</td>
<td>On memory write, nothing is written; on memory read, all bits are read as 1.</td>
</tr>
<tr>
<td></td>
<td>Write to a memory area having the write-protected attribute</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Read from a memory area having the read disable attribute</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Access to an area where memory data do not exist</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Write to the EEPROM by instructions other than EEMOV</td>
<td></td>
</tr>
<tr>
<td>Illegal Instruction</td>
<td>Execution of a code that is not an instruction</td>
<td>Always stops.</td>
</tr>
<tr>
<td></td>
<td>Execution of MOV.B Rn, @-SP or MOV.B @SP + Rn</td>
<td>Continues simulation but the result is not guaranteed.</td>
</tr>
<tr>
<td>Illegal Operation</td>
<td>Incorrect relation between the values in the C flag or H flag of the CCR in the DAA or DAS instruction and the values before adjustment</td>
<td>Continues simulation but the result is not guaranteed.</td>
</tr>
<tr>
<td></td>
<td>Zero division executed by the DIVXU or DIVX3 instruction, or overflow</td>
<td></td>
</tr>
</tbody>
</table>
When a simulation error occurs in the stop mode, the simulator/debugger returns to the command input wait state after stopping instruction execution and displaying the error message. Table 2.6 lists the states of the program counter (PC) at a simulation error stop. The condition code register (CCR) value does not change at a simulation error stop.

Table 2.6 Register States at Simulation Error Stop

<table>
<thead>
<tr>
<th>Error Message</th>
<th>PC Value</th>
</tr>
</thead>
</table>
| Address Error, Memory Access Error | • When an instruction is read:  
                                        | The start address of the instruction that caused the error.  
                                        | • When an instruction is executed:  
                                        | The instruction address following the instruction that caused the error. |
| Illegal Instruction         | The start address of the instruction that caused the error. |
| Illegal Operation           | The instruction address following the instruction that caused the error. |

Use the following procedure when debugging programs that include instructions that generate simulation errors.

1. First execute the program in the stop mode and confirm that there are no errors except those in the intended locations.
2. After confirming the above, execute the program in the continuation mode.

Note: If an error occurs in the stop mode and simulation is continued after changing the simulator/debugger mode to the continuation mode, simulation may not be performed correctly. When restarting simulation, always restore the register contents and the memory contents to the state prior to the occurrence of the error.

Break Due to a Trace Buffer Overflow: After the [Break] mode is specified with [Trace Buffer Full Handling] in the [Trace Acquisition] dialog box, the simulator/debugger stops execution when the trace buffer becomes full. The following message is displayed in the [Output] window when execution is stopped.

Trace Buffer Full
**Break Due to Execution of the SLEEP Instruction:** When the SLEEP instruction is executed during instruction execution, the simulator/debugger stops execution. The following message is displayed in the [Output] window when execution is stopped.

Sleep

Note: When restarting execution, change the PC value to the instruction address at the restart location.

**Break Due to the [Stop] Button:** Users can forcibly terminate execution by clicking the [HALT] button during instruction execution. The following message is displayed on the status bar when execution is stopped.

Stop

Execution can be resumed with the GO or STEP command.
2.16 Floating-Point Data

Floating-point numbers can be used for the following real-number data, which makes floating-point data processing easier. The following data can be specified for floating-point data:

- Data when the break type is set to [Break Data] or [Break Register] in the [Select Break Type] dialog box
- Data in the [Memory] window
- Data in the [Fill Memory] dialog box
- Data in the [Search Memory] dialog box
- Input data in the [Register] dialog box

The floating-point data format conforms to the ANSI C standard.

In the simulator/debugger, the round-to-nearest (RN) mode is applied as the rounding mode for floating-point decimal-to-binary conversion.

If a denormalized number is specified for binary-to-decimal or decimal-to-binary conversion, it is left as a denormalized number in RN mode. If an overflow occurs during decimal-to-binary conversion, the infinity is returned in RN mode.

2.17 Display of Function Call History

The simulator/debugger displays the function call history in the [Stack Trace] window when simulation stops, which enables program execution flow to be checked easily. Selecting a function name in the [Stack Trace] window displays the corresponding source program in the [Editor] window. This allows the function that has called the current function to also be checked.

The displayed function call history is updated in the following cases:

- When simulation stops due to the break conditions described in section 2.15, Break Conditions.
- When register values are modified while simulation stops due to the above break conditions.
- While single-step execution is performed.

For details, refer to section 17.15, Viewing the Function Call History in the High-performance Embedded Workshop V.4.03 User’s Manual.
2.18 Performance Measurement

The simulator/debugger has the profiler function and performance analysis function for performance measurement of the user program.

2.18.1 Profiler

The profiler function displays the memory address and size allocated to functions and global variables, the number of function calls, and the profile data for the entire user program. The profile data to be displayed depends on the CPU.

Profile information is displayed in list, tree, and chart formats.

Profile information is useful in optimizing user programs by reducing the size and putting the most frequently called functions in-line.

When using the profile information saved in a file, it is possible to optimize user programs based on dynamic information using the optimizing linkage editor.

For details, refer to section 3.6, Viewing the Profile Information, and description of PROfile in section 4.2.4, Optimize Option in the Optimizing Linkage Editor User’s Manual.

2.18.2 Performance Analysis

The performance analysis function displays the number of execution cycles and function calls for the specified function in the user program. Since performance data for only the specified function is acquired, faster simulation is possible. For details, refer to section 3.7, Analyzing Performance.
2.19 Pseudo-Interrupts

The simulator/debugger can generate pseudo-interrupts during simulation in the following two ways:

1. Pseudo-interrupts generated by satisfaction of break conditions
   A pseudo-interrupt can be generated using a break command to specify [Interrupt] as the action when a break condition is satisfied. For details, refer to section 3.4, Using the Simulator/Debugger Breakpoints.

2. Pseudo-interrupts generated from windows
   A pseudo-interrupt can be generated by clicking a button in the [Trigger] or [GUI I/O] window. For details, refer to section 3.9, Generating a Pseudo-Interrupt Manually.

If another pseudo-interrupt occurs between a pseudo-interrupt occurrence and its acceptance, only the interrupt that has a higher priority can be accepted.

3. Break by pseudo-interrupts
   The user can select whether or not to cause a break when a pseudo-interrupt occurs. This can be set in the [Simulator System] dialog box or by the EXEC_STOP_SET command.

Note: In the pseudo-interrupts, whether an interrupt is accepted is determined by interrupt information [Priority], not the vector number. Note that when H’8 is specified as the priority level of an interrupt, that interrupt is always accepted. The simulator/debugger does not simulate the operation of the interrupt controller.
2.20 Coverage

The simulator/debugger acquires instruction coverage information during instruction execution within the measurement range specified by the user.

In the measurement range, addresses are directly specified, and all functions in a file whose name has been specified are set.

The state of each instruction execution can be monitored through the instruction coverage information. In addition, this information can be used to determine which part of a program has not been executed.

The [Coverage] window displays the acquired instruction coverage information:

The instruction coverage information can be displayed in the [Editor] window by highlighting the column corresponding to the source line of the executed instruction.

For the address range or function to be measured, the coverage statistical information is displayed in percentage. This gives the user a clear idea how much the program has been executed.

The instruction coverage information can be saved in or loaded from a file. Only a file in the .COV format can be loaded.

For details, refer to section 3.8, Acquiring Code Coverage.
Section 3  Debugging

This section describes the simulator/debugger operations and their related windows and dialog boxes.

For details on the functions common to the HEW listed below, refer to the HEW help information.

- Preparations for Debugging
- Viewing a Program
- Operating Memory
- Displaying Memory Contents as Waveforms
- Displaying Memory Contents as an Image
- Modifying the Memory Contents
- Viewing the I/O Memory
- Looking at Registers
- Executing Your Program
- Viewing the Current Status
- Synchronizing Multiple Debugging Platforms
- Debugging with the Command Line Interface
- Elf/Dwarf2 Support
- Looking at Labels
3.1 Creating the Workspace for Simulator/Debugger

To use the simulator/debugger, a workspace for the simulator/debugger must be created. This section only describes the procedures specific to the simulator/debugger. For details, refer to the HEW user's manual.

3.1.1 Selecting a Debugging Platform

When you create a new workspace, the dialog box shown below appears. Specify the debugging platform in step 7.

![Debug Target Setting Display](image)

Figure 3.1 Debugger Target Setting Display (Step 7)
3.1.2 Setting up a Workspace for the Simulator/Debugger

Set up the workspace for the simulator/debugger in step 8.

Figure 3.2 Debugger Option Setting Display (Step 8)
[Configuration name] By default, the HEW generates two configurations: [Release] and [Debug]. If a debugger target has been selected, a configuration for the selected target is also generated (an abbreviation including the target name). This configuration name can be changed in [Configuration name].

[Detail options] Sets the debugger target options. To modify an option, select [Item] and click [Modify]. If the selected item cannot be modified, [Modify] remains gray even when [Item] is selected.

[Simulator I/O] Simulation for standard I/O or file I/O from the user program is enabled ([Enable]) or disabled ([Disable]).

[Simulator I/O addr.] Address for the above simulated I/O.

[Bus mode] Currently not used by the simulator/debugger.
3.2 Modifying the Simulator/Debugger Settings

This section describes how to modify the simulator system, memory map, and memory resource settings after the simulator/debugger is started.

3.2.1 Modifying the Simulator System

The [System] tab in the [Simulator System] dialog box is used to modify the location to start the simulated I/O and execution mode.

Choose [Setup -> Simulator -> System...] or click the [Simulator System] toolbar button to open the [System] tab in this dialog box.

![Simulator System Dialog Box (System Tab)](image)

Figure 3.3 Simulator System Dialog Box (System Tab)
The following items can be specified in this dialog box:

[CPU] Displays the current CPU. (The CPU must be specified in the [Debug Settings] dialog box.

[Data Area Bit Size] Specifies the number of bits in the data space. The following values can be set in each CPU:
- H8/300HA: 17 to 24
- H8S/2600A and H8S/2000A: 17 to 32

[Program Area Bit Size] Specifies the number of bits in the program area. The following values can be set in each CPU:
- H8/300HA: Same as the number of address space bits
- H8S/2600A and H8S/2000A: 17 to 32

[SYSCR Address] Specifies the SYSCR address.

[Simulated I/O Address] Specifies the start address of a simulated I/O that performs standard input/output or file input/output processing from the user program.
[Enable] Checking this box enables the simulated I/O.

[Response] Specifies the window refresh timing; that is, how many instructions should be executed between refresh operations (D’1 to D’2,147,483,647. The default is D’40000).

[Execution Mode] Specifies whether the simulator/debugger stops or continues operation when a simulation error (including interrupts) occurs. It is also possible to specify an action to take place when an interrupt occurs by clicking the [Detail…] button.
- [Stop] Stops simulation.
- [Continue] Continues simulation.

Clicking the [OK] or [Apply] button stores the modified settings. Clicking the [Cancel] button closes this dialog box without modifying the settings.
3.2.2 Modifying the Memory Map and Memory Resource Settings

The [Memory] tab in the [Simulator System] dialog box is used to set and modify the memory map and memory resource.

Figure 3.4 Simulator System Dialog Box (Memory Tab)

The following items can be specified in this dialog box:

[Memory Map] Displays the memory type, start and end addresses, data bus width, and the number of access cycles.

[Memory Resource] Displays the access type and start and end addresses of the current memory resource.
[Memory Map] can be added, modified, or deleted using the following buttons:

- Adds [Memory Map] items. Clicking this button opens the [Set Memory Map] dialog box (figure 3.5), and memory map items can be added.

- Modifies [Memory Map] items. Select an item to be modified in the list box and click this button. The [Set Memory Map] dialog box (figure 3.5) opens and memory map items can be modified.

- Deletes [Memory Map] items. Select an item to be deleted in the list box and click this button.

[Memory Resource] can be added, modified, or deleted using the following buttons:

- Adds [Memory Resource] items. Clicking this button opens the [Set Memory Resource] dialog box, and memory map items can be specified.

- Modifies [Memory Resource] items. Select an item to be modified in the list box and click this button. The [Set Memory Resource] dialog box opens and memory map items can be modified.

- Deletes [Memory Resource] items. Select an item to be deleted in the list box and click this button.

[Memory Resource] is the same setting information as that of [Memory Resource] of the [Debugger] sheet in the [H8S, H8/300 Standard Toolchain] dialog box. Modifications are reflected on both items.

[Memory Map] and [Memory Resource] can be reset to the default value by the button. Clicking the [OK] or [Apply] button stores the modified settings. Clicking the [Cancel] button closes this dialog box without modifying the settings.

When there is a linkage list file (.map) output by the optimizing linkage editor, the memory resource can be automatically allocated according to the memory map and linkage map information. For details, refer to section 13.1.9, Automatically Allocating the Memory Resource, in the High-performance Embedded Workshop V.4.03 User's Manual.
3.2.3 Set Memory Map Dialog Box

The [Set Memory Map] dialog box specifies the memory map of the target CPU.

The contents displayed in this dialog box depend on the target CPU. The simulator/debugger uses the specified data to calculate the number of cycles for memory accesses.

![Set Memory Map Dialog Box](image)

Figure 3.5 Set Memory Map Dialog Box
The following items are specified:

<table>
<thead>
<tr>
<th>Memory type</th>
<th>Memory type</th>
</tr>
</thead>
<tbody>
<tr>
<td>[ROM]</td>
<td>Internal ROM</td>
</tr>
<tr>
<td>[RAM]</td>
<td>Internal RAM</td>
</tr>
<tr>
<td>[EXT]</td>
<td>External memory</td>
</tr>
<tr>
<td>[IO]</td>
<td>Internal I/O</td>
</tr>
<tr>
<td>[EEPROM]</td>
<td>EEPROM</td>
</tr>
</tbody>
</table>

[Begin address]  Start address of the memory corresponding the memory type
[End address]    End address of the memory corresponding to the memory type
[Data bus size]  Memory data bus width
[Read state count] Number of cycles (“states”) for read access to the specified type of memory
[Write state count] Number of cycles (“states”) for write access to the specified type of memory

Clicking the [OK] button stores the settings. Clicking the [Cancel] button closes this dialog box without modifying the settings.

Note: The memory map setting for the area allocated to a system memory resource cannot be deleted or modified. First delete the system memory resource allocation on the [Memory] tab of the [Simulator System] dialog box, then delete or modify the memory map setting.
3.2.4 Set Memory Resource Dialog Box

The [Set Memory Resource] dialog box sets and modifies memory resources.

![Set Memory Resource Dialog Box](image)

The following items are specified:

- **[Begin Address]** Start address of the memory area to be allocated
- **[End Address]** End address of the memory area to be allocated
- **[Attribute]** Access type
  - [Read] Read only
  - [Write] Write only
  - [Read/Write] Readable/writable

Click the [OK] button after specifying the [Begin Address], [End Address], and [Attribute]. Clicking the [Cancel] button closes this dialog box without modifying the settings.

**Note:** If memory resources are set, memory in the host computer will be used. If the user allocates too much memory resources, operation of the host computer will be extremely slow.
3.3 Simulating Peripheral Functions

The simulator/debugger is able to simulate peripheral functions by using DLL modules. This section describes how to register the peripheral function simulation modules to enable the simulation of individual peripheral functions, and how to set their configurations.

3.3.1 Registering Peripheral Function Simulation Modules

Peripheral function simulation modules can be registered in the [Set Peripheral Function Simulation] dialog box, which is opened on initiation of the simulator/debugger.

Once a peripheral function simulation module has been registered in this dialog box, the simulated peripheral function provided by that simulation module becomes available. The registered settings cannot be modified after the simulator/debugger has fully started up. To change the peripheral function simulation modules that are in use, restart the simulator/debugger to bring up this dialog box.

![Set Peripheral Function Simulation Dialog Box](image)

**Figure 3.7 Set Peripheral Function Simulation Dialog Box**

The following items are specified in this dialog box:

- **[Peripheral Functions]** Shows information on the peripheral function simulation modules.
- **[Module Name]** Names of peripheral functions to be simulated
- **[File Name]** Names of files holding peripheral function simulation modules

36
Check the checkbox under [Module Name] to register the corresponding peripheral function simulation module and make it available.

[Enable All] Enables all peripheral function simulation modules.

[Disable All] Disables all peripheral function simulation modules.

[Detail…] Opens the [Peripheral Module Configuration] dialog box, allowing you to view information on the corresponding peripheral function, and change the address where it starts and the interrupt-source information.

[Peripheral Clock Rate] The ratio between the peripheral clock and the internal clock (the number of cycles of the internal clock corresponding to one cycle of the peripheral clock) is specified here. The clock rate setting can be selected as 1, 2, 3, 4, 6, 8, 12, 16, 24, or 32.

Clicking the [OK] button makes the settings effective. Clicking the [Cancel] button closes this dialog box without storing the settings.

If you do not wish this dialog box to be opened when the simulator/debugger is subsequently initiated, check [Don’t show this dialog box].
3.3.2 Changing the Addresses of Peripheral Functions

The addresses of peripheral functions can be changed in the [Address] tab of the [Peripheral Module Configuration] dialog box. To open this dialog box, select a peripheral function in [ Peripheral Functions] of the [Set Peripheral Function Simulation] dialog box and then press the [Detail…] button.

![Peripheral Module Configuration Dialog Box (Address Tab)](image)

Figure 3.8 Peripheral Module Configuration Dialog Box (Address Tab)
The following items can be set or displayed in this dialog box:

[Module] Name of the peripheral function supported by the selected peripheral function simulation module

[Start Address] Start address of the peripheral function selected in [Module]

[Register Address] Names and addresses of registers of the peripheral function selected in [Module]. It is not possible to change the register addresses.

Clicking the [OK] or [Set] button makes the settings effective. Clicking the [Cancel] button closes this dialog box without storing the settings.
3.3.3 Changing the Interrupt Source Information of Peripheral Functions

The interrupt source information of peripheral functions can be changed in the [Interrupt] tab of the [Peripheral Module Configuration] dialog box. To open this dialog box, select a peripheral function in [Peripheral Functions] of the [Set Peripheral Function Simulation] dialog box and then press the [Detail…] button.

![Peripheral Module Configuration Dialog Box (Interrupt Tab)](image)

The following items can be displayed in this dialog box:

- **Interrupt Source**: Name of the interrupt source (or sources) supported by the peripheral function
- **Vector Number**: Interrupt vector number
- **Priority Register Address/Bit Field Position**: Address of the interrupt priority register and positions of bits in the register
To change the interrupt-source information, open the [Set Interrupt Source Information] dialog box by double-clicking on the line for the interrupt source to be changed.

The following items can be set or displayed in this dialog box:

- **Interrupt Source:** Interrupt source name
- **Interrupt Vector Number:** Interrupt vector number (when the prefix is omitted, values input are taken as decimal, and the display is in decimal notation)
- **Priority Register Address:** Address of the interrupt priority register
- **Priority Register Size:** Size of the interrupt priority register
- **Priority Register Bit Position:** Positions of bits in the interrupt priority register

Clicking the [OK] button makes the settings effective. Clicking the [Cancel] button closes this dialog box without storing the settings.
3.3.4 Allocating Memory Resources to the Interrupt Priority Register

The peripheral function simulation module does not allocate the interrupt priority register (IPR) to a location in memory. Allocate the memory resource for the interrupt priority register (IPR) through user operation. For details on the setting of memory resources, refer to section 3.2.2, Modifying the Memory Map and Memory Resource Settings.

3.3.5 Viewing the Names of Connected Peripheral Functions

After the simulator/debugger has been initiated, [Peripheral Modules] on the [Platform] sheet of the [Status] window shows the names of the peripheral functions that are connected.

3.4 Using the Simulator/Debugger Breakpoints

Sophisticated breakpoint functions are available in the simulator/debugger in addition to the HEW standard PC breakpoints. The user can specify break conditions and actions after a break condition is satisfied, and can display the breakpoints set.

3.4.1 Listing the Breakpoints

Choose [View -> Code -> Eventpoints] or click the [Eventpoints] toolbar button to open the [Event] window, which lists the breakpoints set.

![Event Window](image)

**Figure 3.11 Event Window**
The following items are displayed:

[Type] Break types
   [BP]: PC break
   [BA]: Access break
   [BD]: Data break
   [BR]: Register break (register name)
   [BS]: Sequential break
   [BCY]: Number-of cycles break

[State] Whether the breakpoint is enabled or disabled
   [Enable]: Valid
   [Disable]: Invalid

[Condition] Condition that causes a break. The contents to be displayed depend on the type of the break. When the type of the break is BR, the register name is displayed, and when the type of the break is BCY, the number of cycles is displayed.
   BP: PC = Program counter (Corresponding file name, line, and symbol name)
   BA: Address = Address (Symbol name)
   BD: Address = Address (Symbol name)
   BR: Register = Register name
   BS: PC = Program counter (Corresponding file name, line, and symbol name)
   BCY: Cycle = Number of cycles (displayed in hexadecimal)

[Action] Operation of the simulator/debugger when a break condition is satisfied.
   [Stop]: Execution halts
   [File Input] (file name) [File state]: Memory data is read from file
   [File Output] (file name) [File state]: Memory data is written to file
   [Interrupt] (Interrupt type/priority): Interrupt processing

Conditions specifying [Stop] for [Action] is displayed on the [Software Break] tab and the conditions specifying another action type is on the [Software Event] tab.
3.4.2 Setting a Breakpoint

Selecting [Add...] from the pop-up menu in the [Event] window opens the [Select Break Type] dialog box, which allows the user to set a breakpoint.

Two further dialog boxes can be opened from the [Select Break Type] dialog box: [Set xx Condition] for specifying a break condition and [Set xx Action] for specifying an action to take when the break condition is satisfied. To open the [Select Break Type] dialog box from the [Event] window when you wish to select [Stop] as [Action type] in the [Select Break Type] dialog box, select [Add...] from the pop-up menu on the [Software Break] tab; if you wish to select another action type, select [Add...] from the pop-up menu on the [Software Event] tab.

Selecting a Break Type:

Selecting [Add...] from the popup menu on the [Event] window opens the [Select Break Type] dialog box. Select a break type in the [Break type] field of this dialog box.

![Select Break Type Dialog Box](image)

**Figure 3.12 Select Break Type Dialog Box**

The following options are available:

[Break type]

- [PC Breakpoint]: Breakpoint set at an instruction
- [Break Access]: Break on access to a memory range
- [Break Data]: Break on detection of a memory value
- [Break Register]: Break on detection of a register value
- [Break Sequence]: Sequential breakpoints
- [Break Cycle]: Break after the specified number of cycles
Setting Break Conditions:

Click on [Detail...] after selecting the break type in the [Select Break Type] dialog box. This opens a dialog box that allows you to set conditions for the selected break type.

- [PC Breakpoint]

![Set PC Breakpoint Condition Dialog Box](image)

Up to 1024 PC-breakpoint conditions can be specified.

- **[Address]**: Address of the instruction where a break will occur
- **[Count]**: Number of times that the specified instruction is fetched
  (1 to 16,383; the default value is 1; if the prefix is omitted, values input are taken as decimal, and the display is in decimal notation).
[Break Access]

Figure 3.14  Set Access Break Condition Dialog Box

Up to 1024 access break conditions can be specified.
[Begin address]: First address of the range of memory for which access generates a break
[End address]: Last address of the range of memory for which access generates a break (if no data is input, the range corresponds to the first address alone)
[Access type]: Read, write, or read/write

[Break Register]

Figure 3.15  Set Register Break Condition Dialog Box
Up to 1024 register break conditions can be specified.

- **[Register]**: Register name for which the break condition is specified
- **[Option]**: Match or mismatch with the data
- **[Data]**: Data value used in the break condition (if no data is input here, a break will occur whenever data is written to the register)
- **[Data mask]**: Mask condition (specifying 0 for a bit masks the bit)
- **[Size]**: Data size

- **[Break Sequence]**

![Figure 3.16 Set Break Sequence Condition Dialog Box](image)

Only one sequential break condition can be specified.

- **[Address1]** to **[Address8]**: Addresses that must be passed as conditions to generate the break (not all of the eight breakpoints have to be set).
• [Break Cycle]

![Set Break Cycle Condition dialog box]

Figure 3.17 Set Number-of-Cycles Break Condition Dialog Box

Up to 1024 number-of-cycles break conditions can be specified.

- [Cycle]: Number of cycles required to cause a break (H'1 to H'FFFFFFFF).
  The condition will be satisfied by execution for the number of cycles in
  the [Cycle] setting × n.
  However, the specified number of cycles may differ from the number
  of cycles on which the condition is satisfied.

- [Count]: Number of times the break will occur
  [ALL]: The break will occur whenever the condition is satisfied.
  [Times]: The break will only occur up to the number of times specified as
  [Times] (1 to 65535; if the prefix is omitted, values input are taken as
  hexadecimal, and the display is in hexadecimal notation).
• [Break Data]

![Set Break Data Condition Dialog Box](image)

Figure 3.18 Set Data Break Condition Dialog Box

Data break conditions should be set as follows.

Up to 1024 data break conditions can be specified.

- **Address**: Address in memory for which the break condition is specified
- **Option**: How the data value is used to form the condition that must be satisfied for break generation
  - **Equal**: The value written to memory matches [Data].
  - **Not equal**: The value written to memory does not match [Data].
  - **Inverse sign**: The sign of the value written to memory is the inverse of that for the previous value.
  - **Difference**: The difference between the current and previous values written to memory exceeds [Data].
- **Data**: Data value used in the break condition
- **Data mask**: Mask condition (specifying 0 for a bit masks the bit). This option is only available when [Equal] or [Not equal] has been selected.
- **Size**: Data size
- **Sign**: Sign of the data.
  This option is only available when [Difference] has been selected.

Note: Since [Inverse sign] and [Difference] require comparison of the data with the value previously written to memory, the break will never occur on the first test after a reset or break generation when either of these conditions has been selected.
Selecting an Action in Response to a Break:

If you click on [OK] after setting break conditions in the dialog boxes described on the preceding pages, the [Select Break Type] dialog box is opened again. Select an action type in the [Action type] field of this dialog box.

![Select Break Type Dialog Box](image)

**Figure 3.19 Select Break Type Dialog Box**

The following options are available:

- **[Stop]**: Execution of the user program is stopped when the condition is satisfied.
- **[File Input]**: The contents of a specified file are read out and written to the specified memory when the condition is satisfied.
- **[File Output]**: The contents of the specified memory are read out and written to the specified file when the condition is satisfied.
- **[Interrupt]**: Interrupt processing proceeds when the condition is satisfied.
Setting Details of the Action:

Click on [Detail…] after selecting the action type in the [Select Break Type] dialog box. This opens a dialog box that allows you to set details of the selected action.

- **[File Input]**

![Set File Input Action Dialog Box](image)

**Figure 3.20  Set File Input Action Dialog Box**

When the condition is satisfied, data are read out from the specified file and written to the specified location in memory.

- **[Input file]**: File from which data are to be read out. When reading out by the simulator/debugger reaches the end of the file, reading out recommences from the beginning of the same file.
- **[Address]**: Memory address to which data should be written.
- **[Data size]**: Size of each data value in bytes (1/2/4/8).
- **[Count]**: Number of values to be written (H’1 to H’FFFFFFFF; when the prefix is omitted, values input are taken as decimal, and the display is in decimal notation).
[File Output]

Figure 3.21 Set File Output Action Dialog Box

When the condition is satisfied, the contents at the specified location in memory are written to the specified file.

- **[Output file]**: Data file to which data are written.
- **[Append]**: Selects whether the data should be appended to the file if an existing file is specified as the output file.
- **[Address]**: Memory address to read data from.
- **[Data size]**: Size of each data value to be read (1/2/4/8).
- **[Count]**: Number of values to be read (H'1 to H'FFFFFFFF; when the prefix is omitted, values input are taken as decimal, and the display is in decimal notation).
When the condition is satisfied, interrupt processing proceeds. For details, refer to section 2.19, Pseudo-Interrupts.

[Interrupt type 1]: Sets the following values for each CPU (when the prefix is omitted, values input are taken as hexadecimal, and the display is in hexadecimal notation)

[Priority]: Interrupt priority (H'0 to H'11; when the prefix is omitted, values input are taken as hexadecimal, and the display is in hexadecimal notation).

Whether or not the interrupt is accepted is determined by the CPU's specification of the selected debugging platform. However, when H'8 or larger is specified for the priority, interrupts are always accepted.
• **Point for Caution**

When the same file is specified for multiple [File Input] actions, the simulator/debugger will read data from the file in the order of condition satisfaction. When the same file is specified for multiple [File Output] actions, the simulator/debugger will write data to the file in the order of condition satisfaction. However, when the same file is specified for [File Input] and [File Output], the only valid action is that for the first condition to be satisfied.

3.4.3 **Modifying Breakpoints**

Select a breakpoint to be modified, and choose [Edit...] from the pop-up menu to open the [Select Break Type] dialog box, which allows the user to modify the break conditions. The [Edit...] menu is only available when one breakpoint is selected.

3.4.4 **Enabling a Breakpoint**

Select a breakpoint and choose [Enable] from the pop-up menu to enable the selected breakpoint.

3.4.5 **Disabling a Breakpoint**

Select a breakpoint and choose [Disable] from the pop-up menu to disable the selected breakpoint. When a breakpoint is disabled, the breakpoint will remain in the list, but a break will not occur when the specified conditions have been satisfied.

3.4.6 **Deleting a Breakpoint**

Select a breakpoint and choose [Delete] from the pop-up menu to remove the selected breakpoint. To retain the breakpoint but not have it cause a break when its conditions are met, use the [Disable] option (see section 3.4.5, Disabling a Breakpoint).

3.4.7 **Deleting All Breakpoints**

Choose [Delete All] from the pop-up menu to remove all breakpoints.
3.4.8 Viewing the Source Line for a Breakpoint

Select a breakpoint and choose [Go to Source] from the pop-up menu to open the [Source] or [Disassembly] window at the address of the breakpoint. The [Go to Source] menu is only available when one breakpoint is selected.

3.4.9 Closing Input or Output File

Select a breakpoint and choose [Close File] from the pop-up menu to close the selected [File Input] or [File Output] data file and to reset the address to read the file.

3.4.10 Closing All Input and Output Files

Choose [Close All Files] from the pop-up menu to close all [File Input] and [File Output] data files and to reset the address for reading the file.
3.5 Viewing Trace Information

The simulator/debugger acquires the results of each instruction execution as trace information and displays it in the [Trace] window. The conditions for the trace information acquisition can be specified in the [Trace Acquisition] dialog box.

3.5.1 Opening the Trace Window

To open the [Trace] window, choose [View -> Code -> Trace] or click the [Trace] toolbar button.

3.5.2 Specifying Trace Acquisition Conditions

After the [Trace] window opens, specify the trace acquisition conditions in the [Trace Acquisition] dialog box. To open this dialog box, choose [Acquisition...] from the pop-up menu.

![Trace Acquisition Dialog Box](image)

Figure 3.23 Trace Acquisition Dialog Box
This dialog box specifies the conditions for trace information acquisition.

[Trace Start/Stop]
- [Disable] Disables trace information acquisition.
- [Enable] Enables trace information acquisition.

[Instruction Type]
- [Instruction] Acquires trace information for all instructions.
- [Subroutine] Acquires trace information for the subroutine instructions only.

[Trace Buffer Full Handling]
- [Continue] Continues acquiring trace information even if the trace information acquisition buffer becomes full.
- [Break] Stops execution when the trace information acquisition buffer becomes full.

The trace buffer capacity can be selected from 1 Kbyte (1,024 records), 4 Kbytes (4,096 records), 16 Kbytes (16,384 records), 32 Kbytes (32,768 records), 64 Kbytes (65,536 records), 128 Kbytes (131,072 records), or 256 Kbytes (262,144 records) in [Trace Capacity].

Clicking the [OK] button stores the settings. Clicking the [Cancel] button closes this dialog box without modifying the settings.
3.5.3 Acquiring Trace Information

After trace acquisition is enabled, trace information is acquired during instruction execution. The acquired information will be displayed in the [Trace] window.

![Trace Window](Figure 3.24)

This window displays the following trace information items:

- **[PTR]** Pointer in the trace buffer (0 for the last executed instruction)
- **[Cycle]** Total number of instruction execution cycles (cleared by instruction-execution reset)
- **[Address]** Instruction address
- **[CCR]** Displays the contents of the condition code register (CCR) as a mnemonic.
- **[Mult]** Displays the flag in the multiplier as a mnemonic (H8S/2600 series only).
- **[Instruction]** Instruction mnemonic
- **[Access Data]** Data access information (display format: destination <- accessed data)
- **[Source]** C/C++ or assembly-language source programs
- **[Label]** Labels
3.5.4 Searching for a Trace Record

Use the [Trace Search] dialog box to search for a trace record. To open this dialog box, choose [Find...] from the pop-up menu.

![Trace Search Dialog Box](image)

This dialog box specifies the conditions for searching trace information. Specify a search item in [Item] and search for the specified contents in [Value].

- **[PTR]** Pointer in the trace buffer (0 for the last executed instruction, specify in the form of -nnn)
- **[Cycle]** Total number of instruction execution cycles
- **[Address]** Instruction address
- **[Instruction]** Instruction mnemonic

Clicking the [OK] button stores the settings and starts searching. Clicking the [Cancel] button closes this dialog box without searching.

When a trace record that matches the search conditions is found, the line for the trace record will be displayed in blue. When no matching trace record is found, a message dialog box will appear.

If a search operation is successful, choosing [Find Next] from the pop-up menu will move to the next found item.
3.5.5 Clearing the Trace Information

Choose [Clear] form the pop-up menu to empty the trace buffer that stores the trace information. If more than one [Trace] window is open, all [Trace] windows will be cleared as they all access the same buffer.

3.5.6 Saving the Trace Information in a File

Choose [Save...] from the pop-up menu to open the [Save As] dialog box, which allows the user to save the contents of the trace buffer as a text file. A range can be specified based on [PTR]. Note that this file cannot be reloaded into the trace buffer.

3.5.7 Viewing the Source File

The [Editor] window corresponding to the selected trace record can be displayed in the following two ways:

- Select a trace record and choose [View Source] from the pop-up menu.
- Double-click a trace record

The [Editor] or [Disassembly] window opens and the selected line is marked with a cursor.

3.5.8 Trimming the Source

Choose [Trim Source] from the pop-up menu to remove the white space from the left side of the source.

When the white space is removed, a check mark is shown to the left of the [Trim Source] menu. To restore the white space, choose [Trim Source] while the check mark is shown.
3.5.9 Analyzing Statistical Information

Choose [Statistic] from the pop-up menu to open the [Trace Statistic] dialog box and analyze statistical information under the specified conditions.

![Trace Statistic Dialog Box](Figure 3.26)

This dialog box allows the user to analyze statistical information concerning the trace information. The target of analysis is specified in [Item] and the input value or character string is specified by [Start] and [End].

When [Default] is selected, the input value or character string cannot be specified as a range. To specify a range, select [Range].
[Set] Adds a new condition to the current one
[New] Creates a new condition
[Result] Obtains the result of statistical information analysis
[Clear] Clears all condition and results of statistical information analysis

Clicking the [Close] button closes this dialog box.
3.6 Viewing the Profile Information

The profile function enables function-by-function measurement of the performance of the application program in execution. This makes it possible to identify parts of an application program that degrade its performance and the reasons for such degradation.

The HEW displays the results of measurement in three windows, according to the method and purpose of viewing the profile data.

3.6.1 Stack Information Files

The profile function allows the HEW to read the stack information files (extension: .SNI) which are output by the optimizing linkage editor (ver. 7.0 or later). Each of these files contains information related to the calling of static functions in the corresponding source file. Reading the stack information file makes it possible for the HEW to display information related to the calling of functions without executing the user application (i.e. before measuring the profile data). However, this feature is not available when [Setting->Only Executed Functions] is checked in the pop-up menu of the [Profile] window.

When the HEW does not read any stack information files, only the data on the functions executed during measurement will be displayed by the profile function.

To make the linkage editor create a stack information file, choose [Build -> H8S, H8/300 Standard Toolchain...], and select [Other] from the [Category] list box and check the [Stack information output] box in the [Link/Library] sheet of the [Standard Toolchain] dialog box.
Figure 3.27 Standard Toolchain Dialog Box (1)
3.6.2 Profile Information Files

To create a profile information file, measure a profile data of the application program then choose the [Output Profile Information Files…] menu option from the pop-up menu of the [Profile] window and specify the file name.

This file contains information on the number of times functions are called and global variables are accessed. The optimizing linkage editor (ver. 7.0 or later) is capable of reading the profile information file and optimizing the allocation of functions and variables in correspondence with the state of the actual operation of the program.

To input the profiler information file to the linkage editor, choose [Optimize] from the [Category] list box and check the [Include profile] box in the [Link/Library] sheet of the [Standard Toolchain] dialog box, and specify the name of the profile information file.
To enable the settings in the [Include profile] box, specify the [Optimize] list box as some setting other than [None].
3.6.3 Loading Stack Information Files

You can select whether or not to read the stack information file in a message box for confirmation that is displayed when a load module is loaded. Clicking the [OK] button of the message box loads the stack information file. The message box for confirmation will be displayed when:

- There are stack information files (extension: .SNI)
- The [Load Stack Information Files (SNI files)] check box is checked in the [Confirmation] tab of the [Options] dialog box (figure 3.29) that can be opened by choosing [Setup -> Options...] from the main menu.
Figure 3.29   Options Dialog Box
3.6.4 Enabling the Profile

Choose [View->Performance->Profile] to open the [Profile] window.

Choose [Enable Profiler] from the pop-up menu of the [Profile] window. The item on the menu will be checked.

3.6.5 Specifying Measurement Mode

You can specify whether to trace functions calls while profile data is acquired. When function calls are traced, the relations of function calls during user program execution are displayed as a tree diagram. When not traced, the relations of function calls cannot be displayed, but the time for acquiring profile data can be reduced.

To stop tracing function calls, choose [Disable Tree (Not traces function call)] from the pop-up menu in the [Profile] window (a check mark is shown to the left of the menu item).

When acquiring profile data of the program in which functions are called in a special way, such as task switching in the OS, stop tracing function calls.

3.6.6 Executing the Program and Checking the Results

After the user program has been executed and execution has been halted, the results of measurement are displayed in the [Profile] window.

The [Profile] window has two sheets; a [List] sheet and a [Tree] sheet.
3.6.7 List Sheet

This sheet lists functions and global variables and displays the profile data for each function and variable.

![List Sheet](image)

- Clicking the column header sorts the items in an alphabetical or ascending/descending order.
- Clicking the [Function/Variable] or [Address] column displays the source program corresponding to the address in the line.

Right-clicking on the mouse within the window displays a pop-up menu. For details on this pop-up menu, refer to section 3.6.8, Tree Sheet.
3.6.8 Tree Sheet

This sheet displays the relation of function calls along with the profile data that are values when the function is called. This sheet is available when [Disable Tree (Not traces function call)] is not selected from the pop-up menu in the [Profile] window.

Double-clicking a function in the [Function] column expands or reduces the tree structure display. The expansion or reduction is also provided by the “+” or “-” key. Double-clicking the [Address] column displays the source program corresponding to the specific address.

Right-clicking on the mouse within the window displays a pop-up menu. Supported menu options are as follows:

- **View Source**
  Displays the source program or disassembled memory contents for the address in the selected line.

- **View Profile-Chart**
  Displays the [Profile-Chart] window focused on the function in the specified line.

- **Enable Profiler**
  Toggles acquisition of profile data. When profile data acquisition is enabled, a check mark is shown to the left of the menu text.
• Not trace the function call
   Stops tracing function calls while profile data is acquired. This menu is used when acquiring
   profile data of the program in which functions are called in a special way, such as task
   switching in the OS.
   To display the relation of function calls in the [Tree] sheet of the [Profile] window, acquire
   profile data without selecting this menu. In addition, do not select this menu when optimizing
   the program by the optimizing linkage editor using the acquired profile information file.
• Find…
   Displays the [Find Text] dialog box to find a character string in the [Function] column. Search
   is started by entering a character string to be found in the edit box and clicking [Find Next] or
   pressing the Enter key.
• Find Data…
   Displays the [Find Data] dialog box.

![Find Data Dialog Box](image)

Figure 3.32  Find Data Dialog Box

By selecting the column to be searched in the [Column] combo box and the search type in the
[Find Data] group then pressing [Find Next] button or Enter key, search is started. If the [Find
Next] button or the Enter key is input repeatedly, the second larger data (the second smaller
data when Minimum is specified) is searched for.

• Clear Data
   Clears the number of times functions are called and the profile data. Data in the [List] sheet of
   the [Profile] window and the data in the [Profile-Chart] window are also cleared.
• Output Profile Information Files…
  Displays the [Save Profile Information Files] dialog box. Profiling results are saved in a profile information file (.pro extension). The optimizing linkage editor optimizes user programs according to the profile information in this file. For details of the optimization using the profile information, refer to the manual of the optimizing linkage editor.

Note: If profile information has been acquired by choosing the [Not trace the function call] menu, the program cannot be optimized by the optimizing linkage editor.

• Output Text File…
  Displays the [Save Text of Profile Data] dialog box. Displayed contents are saved in a text file.

• Setting
  This menu has the following submenus (the menus available only in the [List] sheet are also included).
  — Show Functions/Variables
    Displays both functions and global variables in the [Function/Variable] column.
  — Show Functions
    Displays only functions in the [Function/Variable] column.
  — Show Variables
    Displays only global variables in the [Function/Variable] column.
  — Only Executed Functions
    Only displays the executed functions. If a stack information file (.sni extension) output from the optimizing linkage editor does not exist in the directory where the load module is located, only the executed functions are displayed even if this check box is not checked.
  — Include Data of Child Functions
    Sets whether or not to display information for a child function called in the function as profile data.

• Properties…
  This menu cannot be used in this simulator/debugger.
3.6.9 Profile-Chart Window

The [Profile-Chart] window displays the relation of calls for a specific function. This window displays the specified function in the middle, with the callers of the function on the left and the callees of the function on the right. The numbers of times the function calls the functions or is called by the functions are also displayed in this window.

Right-clicking the mouse within the window displays a pop-up menu. Supported menu options are as follows:

- **View Source**
  Displays the source program or disassembled memory contents for the address of the function on which the cursor is placed when the right-hand mouse button is clicked. If the cursor is not placed on a function when the right-hand mouse button is clicked, this menu option remains gray.

- **View Profile-Chart**
  Displays the [Profile-Chart] window for the specific function on which the cursor is placed when the right-hand mouse button is clicked. If the cursor is not placed on a function when the right-hand mouse button is clicked, this menu option remains gray.

- **Enable Profiler**
  Toggles acquisition of profile data. When profile data acquisition is enabled, a check mark is shown to the left of the menu text.
• Clear Data
  Clears the number of times functions are called. Data in the [List] and [Tree] sheets of the [Profile] window are also cleared.

• Multiple View
  If a further [Profile-Chart] window is opened while an existing [Profile-Chart] window is already open, this option selects whether a new window is opened or the new data is displayed in the existing window. When a check mark is shown to the left of this menu item, a new window will be opened.

• Output Profile Information Files...
  Displays the [Save Profile Information Files] dialog box. Profiling results are saved in a profile information file (.pro extension). The optimizing linkage editor optimizes user programs according to the profile information in this file. For details on optimization with the profile information, refer to the user’s manual for the optimizing linkage editor.

• Expands Size
  Redo the display with larger intervals between functions. The "+" key can also be used to do this.

• Reduces Size
  Redo the display with smaller intervals between functions. The "-" key can also be used to this.

3.6.10 Types and Purposes of Displayed Data

The profile function is able to acquire the following information:

Address
  You can view the locations in memory to which the functions are allocated. Sorting the list of functions and global variables in order of their addresses allows the user to view the way the items are allocated in the memory space.

Size
  Sorting in order of size makes it easy to find small functions that are frequently called. Setting such functions as inline may reduce the overhead of function calls.

Stack Size
  When there is deep nesting of function calls, pursue the route of the function calls and obtain the total stack size for all of the functions on that route to estimate the amount of stack being used.

Times
  Sorting by the number of calls or accesses makes it easy to identify the frequently called functions and frequently accessed global variables.

Profile Data
  Measurement of a variety of CPU-specific data is also available as follows:
The number of execution cycles is calculated by subtracting the total execution cycles at a specific function call instruction execution from the total execution cycles at a return instruction execution of a specific function.

### 3.6.11 Creating Profile Information Files

To create a profile information file, choose the [Output Profile Information Files...] menu option from the pop-up menu. The [Save Profile Information Files] dialog box is displayed. Pressing the [Save] button after selecting a file name will write the profile information to the selected file. Pressing the [Save All] button will write the profile information to all of the profile information files.

![Save Profile Information Files Dialog Box](image.png)

**Figure 3.34  Save Profile Information Files Dialog Box**
3.6.12 Notes

1. The number of executed cycles for an application program as measured by the profile function includes a margin of error. The profile function only allows the measurement of the proportions of execution time that the functions occupy in the overall execution of the application program. Use the Performance Analysis function to precisely measure the numbers of executed cycles.

2. The names of the corresponding functions may not be displayed when the profile information on a load module with no debugging information is measured.

3. The stack information file (extension: .SNI) must be in the same directory as the load module file (extension: .ABS).

4. It is not possible to store the results of measurement.

5. It is not possible to modify the results of measurement.
3.7 Analyzing Performance

Use the [Performance Analysis] window to select a function name and analyze the performance.

3.7.1 Opening the Performance Analysis Window

Choose [View -> Performance -> Performance Analysis] or click the [PA] toolbar button to open the [Performance Analysis] window.

![Performance Analysis Window](image)

This window displays the number of execution cycles required for each specified function.

The number of execution cycles is calculated as follows:

Execution cycles = total number of execution cycles when execution returns from the function
– total number of execution cycles when the target function is called

The following items are displayed:

[Index] Index number of the set condition

[Function] Name of the function to be measured (or the start address of the function)

[Cycle] Total number of instruction execution cycles

[Count] Total number of calls for the function

[%] Ratio of execution cycle count required for the function to the execution cycle count required for the whole program
3.7.2 Specifying a Target Function

After the [Performance Analysis] window is open, choose [Add Range...] from the pop-up menu or press the Insert key to open the [Performance Option] dialog box, which allows the user to specify a function to be analyzed.

![Figure 3.36 Performance Option Dialog Box](image)

This dialog box specifies a function (including a label) to be evaluated. Up to 255 functions can be specified in total.

Clicking the [OK] button stores the setting. Clicking the [Cancel] button closes this dialog box without setting the function to be evaluated.

Select a function that has been set and choose [Edit Range] from the pop-up menu or press the Enter key to open the [Performance Option] dialog box and to change the function to be evaluated.

3.7.3 Starting Performance Data Acquisition

Choose [Enable Analysis] from the pop-up menu (a check mark is shown to the left of [Enable analysis]) to start acquiring performance analysis data.

3.7.4 Resetting Data

Choose [Reset Counts/Times] from the pop-up menu to clear the current performance analysis data.
3.7.5 Deleting a Target Function

Select a function and choose [Delete Range] from the pop-up menu to delete the selected target function and to recalculate the data within other ranges. The selected function can also be deleted by the Delete key.

3.7.6 Deleting All Target Functions

Choose [Delete All Ranges] from the pop-up menu to delete all the current target functions to be evaluated and to clear the performance analysis data.

3.7.7 Saving the Currently Displayed Contents

The contents currently displayed in the window can be saved in a text file. Select [Save to File...] from the pop-up menu.
3.8 Acquiring Code Coverage

The [Coverage] window acquires code coverage information (C0 coverage and C1 coverage) in the range specified by the user, and displays the information.

3.8.1 Opening the Coverage Window

Choose [View -> Code -> Coverage...] or click the [Coverage] toolbar button to open the [Open Coverage] dialog box.

![Open Coverage Dialog Box](image)

This dialog box specifies the coverage acquiring range. To set coverage for a new range, the following two ways are available:
- Specifying the start and end addresses on the new window

[Start Address] Start address of coverage information display
(When a prefix is omitted, values input are taken as hexadecimal.)

[End Address] End address of coverage information display
(When a prefix is omitted, values input are taken as hexadecimal.)

- Specifying the file on the new window

[File] Source file whose extension is .C or .CPP in the current project.
Functions in the specified file can be set as the coverage range.
If the extension of the file is omitted, .C is complemented.
The file that has other extensions than .C or .CPP cannot be specified.
A placeholder or the [Browse…] button is available.

To use the settings saved in a coverage information file, choose the file from [Open a recent coverage file], or open a file open dialog box by [Browse to another coverage file] and select the file. When [Open a recent coverage file] is selected, up to four recent files that have been saved are displayed.

Clicking [OK] opens the [Coverage] window.

When the [Coverage] window has already been displayed for specifying address, settings are added in the window.

- Coverage window (specifying address)

![Coverage Window (Specifying Address)](image)

Figure 3.38 Coverage Window (Specifying Address)
This window displays the coverage range and statistical information. The following items are displayed:

[Range] Address range
[Statistic] Percentage of the instructions executed within the range
[Status] Enable or Disable status of the coverage range

When the [Coverage] window is closed, the acquired coverage information and the conditions to acquire information will be cleared.

- Coverage window (specifying source file)

![Coverage Window](image)

Figure 3.39 Coverage Window (Specifying Source File)

This window displays the coverage range and statistical information. The following item is displayed:

[Functions] List of functions
[Statistic] Percentage of the instruction executed within the function
[Status] Enable or Disable status of the respective function

Note: The functions can be sorted by their names or percentage, either in ascending or descending order, by clicking the column tab ([Functions] or [Statistic]).

When the [Coverage] window is closed, the acquired coverage information and the conditions to acquire information will be cleared.
3.8.2 Acquiring All Coverage Information

Choose [Enable All] from the pop-up menu and execute the user program to acquire all coverage information. By default, [Enable All] is selected.

3.8.3 Clearing All Coverage Information

Choosing [Clear All] from the popup menu clears all the coverage information that has been acquired.

3.8.4 Viewing the Source Window

Choose [View Source] from the pop-up menu to open the [Editor] window and to display the [Editor] window corresponding to the cursor location in the [Coverage] window.

3.8.5 Specifying the New Coverage Range

Choose [Add Range...] from the pop-up menu to open the [Open Coverage] dialog box (figure 3.37). For the [Open Coverage] dialog box, refer to section 3.8.1, Opening the Coverage Window.

3.8.6 Changing the Coverage Range

- Specifying the coverage range with an address

Choose the coverage range and [Edit Range...] from the pop-up menu to open the [Coverage Range] dialog box.

![Coverage Range Dialog Box (Specifying Address) Image](image)

Figure 3.40 Coverage Range Dialog Box (Specifying Address)
This dialog box specifies the condition to acquire instruction execution information. The following items can be specified.

[Start address] Start address (When a prefix is omitted, values input are taken as hexadecimal.)
[End address] End address (When a prefix is omitted, values input are taken as hexadecimal.)

Clicking [OK] changes the coverage range.

- Specifying the coverage range with a source file

Choose [Edit Range...] from the pop-up menu to open the [Coverage Range] dialog box.

This dialog box specifies the condition to acquire instruction execution information. The following items can be specified.

[File] Source file whose extension is .C or .CPP in the current project. Functions in the specified file can be set as the coverage range.
If the extension of the file is omitted, .C is complemented.
The file that has other extensions than .C or .CPP cannot be specified.
A placeholder or the [Browse...] button is available.

Clicking [OK] changes the coverage range.

3.8.7 Deleting the Selected Coverage Range

Select a coverage range and choose [Delete Range] from the pop-up menu to delete the selected coverage range.
3.8.8 Acquiring Coverage Information

Specify a coverage range, choose [Enable Coverage] from the pop-up menu, and execute the user program to acquire coverage information. By default, [Enable Coverage] is selected.

3.8.9 Clearing Coverage Information

Specify a coverage range and choose [Clear Data] from the pop-up menu to clear the acquired coverage information.

3.8.10 Saving Coverage Information in a File

Choose [Save Data...] from the pop-up menu to open the [Save Data] dialog box, which allows the user to save the coverage information in a file.

![Save Data Dialog Box]

This dialog box specifies the location and name of a coverage information file to be saved. The placeholder or the [Browse...] button can be used.

If a file name extension is omitted, .COV is automatically added. If a file name extension other than .COV or .TXT is specified, an error message will be displayed.
3.8.11 Loading Coverage Information from a File

Choose [Load Data...] from the pop-up menu to open the [Load Data] dialog box, which allows the user to load the coverage information from a file.

![Load Data Dialog Box](image)

This dialog box specifies the location and name of a coverage information file to be loaded. The placeholder or the [Browse...] button can be used.

Only .COV files can be loaded. If a file name extension other than .COV is specified, an error message will be displayed.

3.8.12 Updating the Information

Choose [Refresh] from the pop-up menu to update the [Coverage] window to the latest information.
3.8.13 Confirmation Request Dialog Box

A confirmation request dialog box will appear when [Clear All], [Clear Data], [Edit Range...], or [Delete Range] is clicked or an attempt is made to close the [Coverage] window.

![Confirmation Request Dialog Box]

Clicking [OK] clears the coverage data. Choosing [Save Coverage data] opens the [Save Data] dialog box (figure 3.44) to save the coverage data in a file before it is cleared.
3.8.14 Save Coverage Data Dialog Box

When [File -> Save Session] menu option is clicked, the [Save Coverage Data] dialog box will appear, which allows the user to save the [Coverage] window data in separate files or a single file.

![Save Coverage Data Dialog Box](image)

**Figure 3.45 Save Coverage Data Dialog Box**

When multiple [Coverage] windows are open, a [Save Coverage Data] dialog box will appear for each open coverage window.

Clicking the [No To All] button closes the dialog box without saving any coverage data.

Clicking the [Yes To All] button saves the data of all [Coverage] windows in a single file.

Note: If a file is specified for the coverage range, not all [Coverage] windows can be saved in a single file.
3.8.15 Displaying the Coverage Information in the Editor Window

The coverage information is reflected to the [Editor] window by highlighting the coverage columns corresponding to the source lines of executed instructions. When the coverage settings are modified in the [Coverage] window, the coverage column display will be updated.

![Figure 3.46 Coverage Column (Source)](image-url)
3.8.16 Displaying the Coverage Information in the [Disassembly] Window

The coverage information is reflected to the [Disassembly] window by highlighting the [Coverage – ASM] columns corresponding to the disassembly lines of executed instructions. When the coverage settings are modified in the [Coverage] window, the [Coverage – ASM] column display will be updated.

![Coverage Column (Disassembly)](image)

Figure 3.47 Coverage Column (Disassembly)
3.9 Generating a Pseudo-Interrupt Manually

Windows [Trigger] and [GUI I/O] allow the user to generate a pseudo-interrupt manually by pressing a button on the window.

3.9.1 [Trigger] Window

Choose [View -> CPU -> Trigger] or click the [Trigger] toolbar button to open the [Trigger] window.

![Trigger Window](image)

This window displays trigger buttons that generate pseudo-interrupts manually. The details of the interrupt to be generated by pressing each trigger button can be specified in the [Trigger Setting] dialog box.

Up to 256 trigger buttons can be used.

For details on the interrupt processing in the simulator/debugger, refer to section 2.19, Pseudo-Interrupts.
Setting a trigger button

Choose [Setting...] from the pop-up menu to open the [Trigger Setting] dialog box and to specify the details of the pseudo-interrupt to be generated by pressing each trigger button.

![Trigger Setting Dialog Box]

This dialog box allows the user to specify the details of the pseudo-interrupt to be generated by pressing each trigger button.

- **[Trigger]**: Selects the trigger button to be specified in detail
- **[Name]**: Specifies a name for the selected trigger button; the name will be displayed in the [Trigger] window
- **[Enable]**: Checking this box enables the trigger button.
- **[Interrupt type1]**: Interrupt vector number
- **[Priority]**: Interrupt priority (H'0 to H'11; when the prefix is omitted, values input are taken as hexadecimal, and the display is in hexadecimal notation). Whether or not the interrupt is accepted is determined by the CPU’s specification of the selected debugging platform. However, when H’8 or a larger value is specified for the priority, interrupts are always accepted.
Clicking the [OK] button stores the setting. Clicking the [Cancel] button closes this dialog box without setting the details of the interrupt.

Note: If the [Cancel] button is clicked after multiple trigger button settings are modified, the modifications of all those buttons are canceled.

- Changing the number of trigger buttons

Specify the number of trigger buttons displayed in the [Trigger] window in the [Number of Buttons] submenu in the pop-up menu. [4], [16], [64], or [256] can be selected.

- Changing the size of trigger buttons

Specify the size of trigger buttons displayed in the [Trigger] window in the [Size] submenu in the pop-up menu. [Large], [Normal], or [Small] can be selected.

### 3.9.2 [GUI I/O] Window

Choose [View -> Graphic -> GUI I/O] or click the [GUI I/O] toolbar button to open the [GUI I/O] window.

![GUI I/O Window](image)

**Figure 3.50  GUI I/O Window**
This window displays buttons that generate pseudo-interrupts manually. The details of the interrupt to be generated by pressing each button can be specified in the [Set Button] dialog box.

For details on the interrupt processing in the simulator/debugger, refer to section 2.19, Pseudo-Interrupts.

- Setting a button

Choose [Create Button] from the pop-up menu or click the [Create Button] toolbar button ( ). The mouse cursor turns into a “+” symbol. Create the button by dragging the mouse cursor from a higher-left to a lower-right position.

Double-click the created button to open the [Set Button] dialog box.
Figure 3.52  Set Button Dialog Box
This dialog box allows the user to specify the details of the pseudo-interrupt to be generated by pressing each button.

- **[Button Name]** Specifies a name for the button; the name will be displayed in the [GUI I/O] window.

- **[Select Button Type]** Select [Input] or [Input and Interrupt].

- **[Interrupt]** [Interrupt Type1]** Interrupt vector number

  - **[Priority]** Interrupt priority (H'0 to H'11; when the prefix is omitted, values input are taken as hexadecimal, and the display is in hexadecimal notation). Whether or not the interrupt is accepted is determined by the CPU's specification of the selected debugging platform. However, when H'8 or a larger value is specified for the priority, interrupts are always accepted.
3.10 Standard I/O and File I/O Processing

Use the [Simulated I/O] window to enable the simulation for standard I/O and file I/O from the user program.

3.10.1 Opening the Simulated I/O Window

Choose [View -> CPU -> Simulated I/O] or click the [Simulated I/O] toolbar button to open the [Simulated I/O] window.

![Simulated I/O Window](image)

**Figure 3.53 Simulated I/O Window**

The standard output from the user program is displayed in this window. The key input from this window is handled as the standard input to the user program.
3.10.2 I/O Functions

Table 3.1 lists the supported I/O functions. The function codes have 16-bit address, 24-bit address, and 32-bit address versions. Select the version suitable for the CPU being used.

<table>
<thead>
<tr>
<th>No.</th>
<th>Function Code</th>
<th>Function Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>H'01 (16-bit address)</td>
<td>GETC</td>
<td>Inputs one byte from the standard input</td>
</tr>
<tr>
<td></td>
<td>H'11 (24-bit address)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>H'21 (32-bit address)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>H'02 (16-bit address)</td>
<td>PUTC</td>
<td>Outputs one byte to the standard output</td>
</tr>
<tr>
<td></td>
<td>H'12 (24-bit address)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>H'22 (32-bit address)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>H'03 (16-bit address)</td>
<td>GETS</td>
<td>Inputs one line from the standard input</td>
</tr>
<tr>
<td></td>
<td>H'13 (24-bit address)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>H'23 (32-bit address)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>H'04 (16-bit address)</td>
<td>PUTS</td>
<td>Outputs one line to the standard output</td>
</tr>
<tr>
<td></td>
<td>H'14 (24-bit address)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>H'24 (32-bit address)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>H'05 (16-bit address)</td>
<td>FOPEN</td>
<td>Opens a file</td>
</tr>
<tr>
<td></td>
<td>H'15 (24-bit address)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>H'25 (32-bit address)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>H'06</td>
<td>FCLOSE</td>
<td>Closes a file</td>
</tr>
<tr>
<td>7</td>
<td>H'07 (16-bit address)</td>
<td>FGGETC</td>
<td>Inputs one byte from a file</td>
</tr>
<tr>
<td></td>
<td>H'17 (24-bit address)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>H'27 (32-bit address)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>H'08 (16-bit address)</td>
<td>FPUTC</td>
<td>Outputs one byte to a file</td>
</tr>
<tr>
<td></td>
<td>H'18 (24-bit address)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>H'28 (32-bit address)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>H'09 (16-bit address)</td>
<td>FGGETS</td>
<td>Inputs one line from a file</td>
</tr>
<tr>
<td></td>
<td>H'19 (24-bit address)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>H'29 (32-bit address)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>H'0A (16-bit address)</td>
<td>FPPUTS</td>
<td>Outputs one line to a file</td>
</tr>
<tr>
<td></td>
<td>H'1A (24-bit address)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>H'2A (32-bit address)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>H'0B</td>
<td>FEOF</td>
<td>Checks for end of the file</td>
</tr>
<tr>
<td>12</td>
<td>H'0C</td>
<td>FSEEK</td>
<td>Moves the file pointer</td>
</tr>
<tr>
<td>13</td>
<td>H'0D</td>
<td>FTELL</td>
<td>Returns the current position of the file pointer</td>
</tr>
</tbody>
</table>
To perform I/O processing, use the [Simulated I/O Address] in the [Simulator System] dialog box (refer to section 3.2.1, Modifying the Simulator System) in the following procedure.

1. Set the address specialized for I/O processing in the [Simulated I/O Address], select [Enable] and execute the program.

2. When detecting a subroutine call instruction (BSR or JSR), that is, a simulated I/O instruction to the specified address during user program execution, the simulator/debugger performs I/O processing by using the R0 and R1 values (H8/300 and H8/300L series) or the ER1 value (H8/300H, H8S, and H8SX series) as the parameters.

- Set the function code (table 3.1) to the R0 register

<table>
<thead>
<tr>
<th>MSB</th>
<th>1 byte</th>
<th>1 byte</th>
<th>LSB</th>
</tr>
</thead>
<tbody>
<tr>
<td>H'01</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- Set the parameter block address to the R1 or ER1 register (for the parameter block, refer to each function description)

<table>
<thead>
<tr>
<th>MSB</th>
<th>1 byte</th>
<th>LSB</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- Reserve the parameter block and input/output buffer areas

Each parameter of the parameter block must be accessed in the parameter size.

After the I/O processing, the simulator/debugger resumes simulation from the instruction that follows the simulated I/O instruction.

Refer to the simulator/debugger help about each I/O function.
The following shows an example for inputting one character as a standard input (from a keyboard). Label SYS_CALL is specified as the simulated I/O address.

```
MOV.W #H'0101,R0
MOV.W #PARM,R1
JSR @SYS_CALL
STOP NOP
SYS_CALL NOP
PARM .DATA.W INBUF
INBUF .RES.B 2
.END
```
3.11 Creating a Virtual I/O Panel

The simulator/debugger has a GUI I/O function for simulating a simple key-input or key-output panel of the user target system in a window. This virtual I/O panel is created in the [GUI I/O] window. That is, virtual buttons and virtual LEDs are arranged in this window to allow the input and output of data.

![Example of a GUI I/O Window](image)

Figure 3.54 Example of a GUI I/O Window
3.11.1 Opening the [GUI I/O] Window

Choose [View -> Graphic -> GUI I/O] or click the [GUI I/O] toolbar button to open the [GUI I/O] window.

![GUI I/O Window]

This window is used to arrange the following items.

Button: Press a button for input of data to a virtual port or generation of a virtual interrupt.

Label: A character string which is shown when the value written to a selected address or bit was the specified value and hidden otherwise.

LED: A defined region in which a specified color is displayed (representing illumination of a LED) when the value written to a selected address or bit was the specified value.

Text: A region for the display of a text string.
3.11.2 Creating a Button

Click on the button of the toolbar or choose [Create Button] from the pop-up menu. The mouse cursor turns into a “+” symbol. Create the button by dragging the mouse cursor from a higher-left to a lower-right position.

Figure 3.56 GUI I/O Window (Create Button)
Specifying the event generated by clicking the button

Press the button on the toolbar and double-click on the created button to open the [Set Button] dialog box.

![Set Button Dialog Box]

**Figure 3.57 Set Button Dialog Box**

Enter the name of the button, input port address, and input data. The button name must not include white space.
3.11.3 Creating a Label

Click on the button of the toolbar or choose [Create Label] from the pop-up menu. The mouse cursor turns into a “+” symbol. Drag the mouse cursor from a higher-left to a lower-right position. This shows the frame for the label.

![GUI I/O Window (Create Label)](image)

Press the button on the toolbar or choose [Select Item] from the pop-up menu and double-click on the created label to open the [Set Label] dialog box. Specify the responses to events. The label name must not include white space.
• Response to writing of either value to a selected bit

The settings shown below set up display of the character string “Printing in progress” or “Printer ready” when the value of bit 3 at address 0x3E0 is 0 or 1, respectively.

![Set Label Dialog Box (Bit Selection)](image)

Figure 3.59  Set Label Dialog Box (Bit Selection)
The settings shown below set up display of the character string “Printing in progress” or “Printer ready” when the value 0x10 or 0x20, respectively, is written to address 0x3E0.

Figure 3.60  Set Label Dialog Box (Data Selection)
3.11.4 Creating an LED

Click on the button on the toolbar or choose [Create LED] from the pop-up menu. The mouse cursor turns into a “+” symbol. Drag the mouse cursor from an upper left to a lower right position. This shows the frame for the LED output.

Figure 3.61 GUI I/O Window (Create LED)

Press the button on the toolbar or choose [Select Item] from the pop-up menu and double-click on the created LED to open the [Set LED] dialog box. Specify the events and responses.
Response to writing of either value to a selected bit

The settings shown below set up the display of green or red, respectively, in the LED area when the value of bit 2 at address 0x3E0 is 0 or 1.

![Set LED Dialog Box](image)

**Figure 3.62 Set LED Dialog Box (Bit Selection)**
• Response to writing of specified values to a selected address

The settings shown below set up the display of green or red, respectively, in the LED area when the value 0x10 or 0x20 is written to address 0x3E0.

![Set LED Dialog Box (Data Selection)](image)

**Figure 3.63  Set LED Dialog Box (Data Selection)**

Clicking the [Color 1] or [Color 2] button opens the [Color] dialog box, which allows you to select the color.
3.11.5 Creating Fixed Text

Click the button on the toolbar or choose [Create Text] from the pop-up menu. The mouse cursor turns into a “+” symbol. Create the text box by dragging the mouse cursor from a higher-left to a lower-right position.

Figure 3.64 GUI I/O Window (Create Fixed Text)
• Setting the format for the text

Press the \( \text{\textdollar} \) button on the toolbar and double-click on the created text to open the [Set Text] dialog box.

![Set Text Dialog Box](image)

Figure 3.65 Set Text Dialog Box

Click the [Font…] button to select the font and size for the text. Then click the [Text] and [Back] buttons to specify the colors of the text and its background.
3.11.6 Changing the Size and Position of an Item

Press the button on the toolbar and click on the item. The item is selected as shown in the figure below.

![GUI I/O Window (Item Selected)](image)

Drag the item to change its position or the control points to change its size.

3.11.7 Copying an Item

Press the button on the toolbar or choose [Copy] from the pop-up menu. The mouse cursor turns into a “+” symbol. In this state, click on the item you wish to copy. Press the button on the toolbar or choose [Paste] from the pop-up menu to create a new item with the same size and attributes.

3.11.8 Deleting an Item

Press the button on the toolbar or choose [Delete] from the pop-up menu. The mouse cursor turns into a “+” symbol. In this state, click on the item you wish to delete.
3.11.9  Showing the Grid

Press the button on the toolbar or choose [Display Grid] from the pop-up menu. This displays the grid on the background.

![GUI I/O Window (Show Grid)](image)

Clicking the button again hides the grid.

3.11.10  Saving I/O Panel Information

It is possible to reuse created I/O panels by saving the information in files. Press the button on the toolbar or choose [Save] from the pop-up menu to open the [Save GUI I/O Panel File] dialog box. Specify the directory where the file is to be stored and enter the file name.

3.11.11  Loading I/O Panel Information

Press the button on the toolbar or choose [Load] from the pop-up menu to open the [Load GUI I/O Panel File] dialog box. Specify the file you wish to load. Panel information prior to the load will be deleted.
Section 4  Windows

Table 4.1 lists the windows.

Refer to the simulator/debugger help about the toolbar buttons.

Table 4.1  Simulator/Debugger Windows

<table>
<thead>
<tr>
<th>Window Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Command Line</td>
<td>Debugging with the Command Line Interface</td>
</tr>
<tr>
<td>Coverage</td>
<td>Acquiring Code Coverage</td>
</tr>
<tr>
<td>Disassembly</td>
<td>Viewing the Assembly-Language Code</td>
</tr>
<tr>
<td>Editor</td>
<td>Viewing a Program</td>
</tr>
<tr>
<td>Event</td>
<td>Using the Simulator/Debugger Breakpoints</td>
</tr>
<tr>
<td>GUI I/O</td>
<td>Creating a Virtual I/O Panel</td>
</tr>
<tr>
<td>Image</td>
<td>Displaying Memory Contents as an Image</td>
</tr>
<tr>
<td>IO</td>
<td>Viewing the I/O Memory</td>
</tr>
<tr>
<td>Label</td>
<td>Looking at Labels</td>
</tr>
<tr>
<td>Local</td>
<td>Looking at Variables (local variables)</td>
</tr>
<tr>
<td>Memory</td>
<td>Viewing a Memory Area</td>
</tr>
<tr>
<td>Profile/Profile-Chart</td>
<td>Viewing the Profile Information</td>
</tr>
<tr>
<td>Performance Analysis</td>
<td>Analyzing Performance</td>
</tr>
<tr>
<td>Register</td>
<td>Looking at Registers</td>
</tr>
<tr>
<td>Simulated I/O</td>
<td>Standard I/O and File I/O Processing</td>
</tr>
<tr>
<td>Stack Trace</td>
<td>Viewing the Function Call History</td>
</tr>
<tr>
<td>Status</td>
<td>Viewing the Current Status</td>
</tr>
<tr>
<td>Trace</td>
<td>Viewing the Trace Information</td>
</tr>
<tr>
<td>Trigger</td>
<td>Generating a Pseudo-Interrupt Manually</td>
</tr>
<tr>
<td>Watch</td>
<td>Looking at Variables (any variables)</td>
</tr>
<tr>
<td>Wave</td>
<td>Displaying Memory Contents as Waveforms</td>
</tr>
</tbody>
</table>
Section 5 Command Lines

5.1 Commands (Functional Order)

The following tables show the commands in functional order.

Refer to the simulator/debugger help about each command.

5.1.1 Execution

<table>
<thead>
<tr>
<th>Command Name</th>
<th>Abbreviation</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>GO</td>
<td>GO</td>
<td>Executes user program</td>
</tr>
<tr>
<td>GO_RESET</td>
<td>GR</td>
<td>Executes user program from reset vector</td>
</tr>
<tr>
<td>GO_TILL</td>
<td>GT</td>
<td>Executes user program until temporary breakpoint</td>
</tr>
<tr>
<td>HALT</td>
<td>HA</td>
<td>Halts the user program</td>
</tr>
<tr>
<td>RESET</td>
<td>RE</td>
<td>Resets CPU</td>
</tr>
<tr>
<td>STEP</td>
<td>ST</td>
<td>Steps program (by instructions or source lines)</td>
</tr>
<tr>
<td>STEP_MODE</td>
<td>SM</td>
<td>Selects the step mode</td>
</tr>
<tr>
<td>STEP_OUT</td>
<td>SP</td>
<td>Steps out of the current function</td>
</tr>
<tr>
<td>STEP_OVER</td>
<td>SO</td>
<td>Steps program, not stepping into functions</td>
</tr>
<tr>
<td>STEP_RATE</td>
<td>SR</td>
<td>Sets or displays rate of stepping</td>
</tr>
</tbody>
</table>
## 5.1.2 Download

<table>
<thead>
<tr>
<th>Command Name</th>
<th>Abbreviation</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>BUILD</td>
<td>BU</td>
<td>Performs a build on the current project</td>
</tr>
<tr>
<td>BUILD_ALL</td>
<td>BL</td>
<td>Performs a build all on the current project</td>
</tr>
<tr>
<td>BUILD_FILE</td>
<td>BF</td>
<td>Compiles files</td>
</tr>
<tr>
<td>BUILD_MULTIPLE</td>
<td>BM</td>
<td>Builds multiple projects</td>
</tr>
<tr>
<td>CLEAN</td>
<td>CL</td>
<td>Deletes intermediate and output files produced in building</td>
</tr>
<tr>
<td>DEFAULT_OBJECT_FORMAT</td>
<td>DO</td>
<td>Sets the default object (program) format</td>
</tr>
<tr>
<td>FILE_LOAD</td>
<td>FL</td>
<td>Loads an object (program) file</td>
</tr>
<tr>
<td>FILE_LOAD_ALL</td>
<td>LA</td>
<td>Loads all object (program) files</td>
</tr>
<tr>
<td>FILE_SAVE</td>
<td>FS</td>
<td>Saves memory to a file</td>
</tr>
<tr>
<td>FILE_UNLOAD</td>
<td>FU</td>
<td>Unloads an object (program) file from memory</td>
</tr>
<tr>
<td>FILE_UNLOAD_ALL</td>
<td>UA</td>
<td>Unloads all object (program) files from memory</td>
</tr>
<tr>
<td>GENERATE_MAKE_FILE</td>
<td>GM</td>
<td>Generates a build makefile for the current workspace</td>
</tr>
</tbody>
</table>

## 5.1.3 Register

<table>
<thead>
<tr>
<th>Command Name</th>
<th>Abbreviation</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>REGISTER_DISPLAY</td>
<td>RD</td>
<td>Displays CPU register values</td>
</tr>
<tr>
<td>REGISTER_SET</td>
<td>RS</td>
<td>Changes CPU register contents</td>
</tr>
</tbody>
</table>
### 5.1.4 Memory

<table>
<thead>
<tr>
<th>Command Name</th>
<th>Abbreviation</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>CACHE</td>
<td>-</td>
<td>Sets caching on or off</td>
</tr>
<tr>
<td>MEMORY_COMPARE</td>
<td>MC</td>
<td>Compares memory contents</td>
</tr>
<tr>
<td>MEMORY_DISPLAY</td>
<td>MD</td>
<td>Displays memory contents</td>
</tr>
<tr>
<td>MEMORY_EDIT</td>
<td>ME</td>
<td>Modifies memory contents</td>
</tr>
<tr>
<td>MEMORY_FILL</td>
<td>MF</td>
<td>Modifies the content of a memory area by specifying data</td>
</tr>
<tr>
<td>MEMORY_FIND</td>
<td>MI</td>
<td>Finds a string in an area of memory</td>
</tr>
<tr>
<td>MEMORY_MOVE</td>
<td>MV</td>
<td>Moves a block of memory</td>
</tr>
<tr>
<td>MEMORY_TEST</td>
<td>MT</td>
<td>Tests a block of memory</td>
</tr>
</tbody>
</table>

### 5.1.5 Assemble/Disassemble

<table>
<thead>
<tr>
<th>Command Name</th>
<th>Abbreviation</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASSEMBLE</td>
<td>AS</td>
<td>Assembles instructions into memory</td>
</tr>
<tr>
<td>DISASSEMBLE</td>
<td>DA</td>
<td>Disassembles memory contents</td>
</tr>
<tr>
<td>SYMBOL_ADD</td>
<td>SA</td>
<td>Defines a symbol</td>
</tr>
<tr>
<td>SYMBOL_CLEAR</td>
<td>SC</td>
<td>Deletes a symbol</td>
</tr>
<tr>
<td>SYMBOL_LOAD</td>
<td>SL</td>
<td>Loads a symbol information file</td>
</tr>
<tr>
<td>SYMBOL_SAVE</td>
<td>SS</td>
<td>Saves a symbol information file</td>
</tr>
<tr>
<td>SYMBOL_VIEW</td>
<td>SV</td>
<td>Displays symbols</td>
</tr>
</tbody>
</table>
### 5.1.6 Break

<table>
<thead>
<tr>
<th>Command Name</th>
<th>Abbreviation</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>BREAKPOINT</td>
<td>BP</td>
<td>Sets a breakpoint at an instruction address</td>
</tr>
<tr>
<td>BREAK_ACCESS</td>
<td>BA</td>
<td>Specifies a memory range access as a break condition</td>
</tr>
<tr>
<td>BREAK_CLEAR</td>
<td>BC</td>
<td>Deletes breakpoints</td>
</tr>
<tr>
<td>BREAK_CYCLE</td>
<td>BCY</td>
<td>Specifies a cycle as a break condition</td>
</tr>
<tr>
<td>BREAK_DATA</td>
<td>BD</td>
<td>Specifies a memory data value as a break condition</td>
</tr>
<tr>
<td>BREAK_DATA_DIFFERENCE</td>
<td>BDD</td>
<td>Specifies a difference between two values of data in memory as a break condition</td>
</tr>
<tr>
<td>BREAK_DATA_INVERSE</td>
<td>BDI</td>
<td>Specifies inversion of the sign of a value of data in memory as a break condition</td>
</tr>
<tr>
<td>BREAK_DISPLAY</td>
<td>BI</td>
<td>Displays a list of breakpoints</td>
</tr>
<tr>
<td>BREAK_ENABLE</td>
<td>BE</td>
<td>Enables or disables a breakpoint</td>
</tr>
<tr>
<td>BREAK_REGISTER</td>
<td>BR</td>
<td>Specifies a register data as a break condition</td>
</tr>
<tr>
<td>BREAK_SEQUENCE</td>
<td>BS</td>
<td>Sets sequential breakpoints</td>
</tr>
<tr>
<td>SET_DISASSEMBLY_SOFT_BREAK</td>
<td>SDB</td>
<td>Sets or deletes a software breakpoint at the disassembly level</td>
</tr>
<tr>
<td>SET_SOURCE_SOFT_BREAK</td>
<td>SSB</td>
<td>Sets or deletes a software breakpoint at the source level</td>
</tr>
<tr>
<td>STATE_DISASSEMBLY_SOFT_BREAK</td>
<td>TDB</td>
<td>Enables or disables a software breakpoint at the disassembly level</td>
</tr>
<tr>
<td>STATE_SOURCE_SOFT_BREAK</td>
<td>TSB</td>
<td>Enables or disables a software breakpoint at the source level</td>
</tr>
</tbody>
</table>

### 5.1.7 Trace

<table>
<thead>
<tr>
<th>Command Name</th>
<th>Abbreviation</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>TRACE</td>
<td>TR</td>
<td>Displays trace information</td>
</tr>
<tr>
<td>TRACE_ACQUISITION</td>
<td>TA</td>
<td>Enables or disables trace information acquisition</td>
</tr>
<tr>
<td>TRACE_SAVE</td>
<td>TV</td>
<td>Outputs trace information into a file</td>
</tr>
<tr>
<td>TRACE_STATISTIC</td>
<td>TST</td>
<td>Analyzes statistic information</td>
</tr>
</tbody>
</table>
### 5.1.8 Coverage

<table>
<thead>
<tr>
<th>Command Name</th>
<th>Abbreviation</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>COVERAGE</td>
<td>CV</td>
<td>Enables or disables coverage measurement</td>
</tr>
<tr>
<td>COVERAGE_DISPLAY</td>
<td>CVD</td>
<td>Displays coverage information</td>
</tr>
<tr>
<td>COVERAGE_LOAD</td>
<td>CVL</td>
<td>Loads coverage information</td>
</tr>
<tr>
<td>COVERAGE_RANGE</td>
<td>CVR</td>
<td>Sets a coverage range</td>
</tr>
<tr>
<td>COVERAGE_SAVE</td>
<td>CVS</td>
<td>Saves coverage information</td>
</tr>
</tbody>
</table>

### 5.1.9 Performance

<table>
<thead>
<tr>
<th>Command Name</th>
<th>Abbreviation</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>ANALYSIS</td>
<td>AN</td>
<td>Enables or disables performance analysis</td>
</tr>
<tr>
<td>ANALYSIS_RANGE</td>
<td>AR</td>
<td>Sets or displays performance analysis functions</td>
</tr>
<tr>
<td>ANALYSIS_RANGE_DELETE</td>
<td>AD</td>
<td>Deletes a performance analysis range</td>
</tr>
<tr>
<td>PROFILE</td>
<td>PR</td>
<td>Enables or disables profile</td>
</tr>
<tr>
<td>PROFILE_DISPLAY</td>
<td>PD</td>
<td>Displays profile information</td>
</tr>
<tr>
<td>PROFILE_SAVE</td>
<td>PS</td>
<td>Saves the profile information to file</td>
</tr>
</tbody>
</table>

### 5.1.10 Watch

<table>
<thead>
<tr>
<th>Command Name</th>
<th>Abbreviation</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>WATCH_ADD</td>
<td>WA</td>
<td>Adds an item for watching</td>
</tr>
<tr>
<td>WATCH_AUTO_UPDATE</td>
<td>WU</td>
<td>Selects or cancels automatic updating of watched items</td>
</tr>
<tr>
<td>WATCH_DELETE</td>
<td>WD</td>
<td>Deletes a watched item</td>
</tr>
<tr>
<td>WATCH_DISPLAY</td>
<td>WI</td>
<td>Displays the contents of the Watch window</td>
</tr>
<tr>
<td>WATCH_EDIT</td>
<td>WE</td>
<td>Edits the value of a watched item</td>
</tr>
<tr>
<td>WATCH_EXPAND</td>
<td>WX</td>
<td>Expands or collapses a watched item</td>
</tr>
<tr>
<td>WATCH_RADIX</td>
<td>WR</td>
<td>Changes the radix for display of watched items</td>
</tr>
<tr>
<td>WATCH_RECORD</td>
<td>WO</td>
<td>Outputs the history of updating of the values of a watched item to a file</td>
</tr>
<tr>
<td>WATCH_SAVE</td>
<td>WS</td>
<td>Saves the contents of the Watch window to a file</td>
</tr>
</tbody>
</table>
### 5.1.11 Script/Logging

<table>
<thead>
<tr>
<th>Command Name</th>
<th>Abbreviation</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>!</td>
<td></td>
<td>Comment</td>
</tr>
<tr>
<td>ASSERT</td>
<td></td>
<td>Checks if an expression is true or false</td>
</tr>
<tr>
<td>AUTO_COMPLETE</td>
<td>AC</td>
<td>Enables or disables the auto-complete function</td>
</tr>
<tr>
<td>ERASE</td>
<td>ER</td>
<td>Clears the [Command Line] window</td>
</tr>
<tr>
<td>EVALUATE</td>
<td>EV</td>
<td>Evaluates an expression</td>
</tr>
<tr>
<td>LOG</td>
<td>LO</td>
<td>Controls command output logging</td>
</tr>
<tr>
<td>SLEEP</td>
<td></td>
<td>Delays command execution</td>
</tr>
<tr>
<td>SUBMIT</td>
<td>SU</td>
<td>Executes a command file</td>
</tr>
<tr>
<td>TCL</td>
<td></td>
<td>Displays TCL information</td>
</tr>
</tbody>
</table>

### 5.1.12 Memory Resource

<table>
<thead>
<tr>
<th>Command Name</th>
<th>Abbreviation</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>MAP_DISPLAY</td>
<td>MA</td>
<td>Displays memory resource settings</td>
</tr>
<tr>
<td>MAP_SET</td>
<td>MS</td>
<td>Allocates a memory area</td>
</tr>
</tbody>
</table>

### 5.1.13 Simulator/Debugger Settings

<table>
<thead>
<tr>
<th>Command Name</th>
<th>Abbreviation</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>EXEC_MODE</td>
<td>EM</td>
<td>Sets and displays execution mode</td>
</tr>
<tr>
<td>EXEC_STOP_SET</td>
<td>ESS</td>
<td>Sets or displays the execution mode at the occurrence of an interrupt</td>
</tr>
</tbody>
</table>

### 5.1.14 Standard I/O and File I/O

<table>
<thead>
<tr>
<th>Command Name</th>
<th>Abbreviation</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>SIMULATEDIO_CLEAR</td>
<td>SIOC</td>
<td>Clears the contents of the [Simulated I/O] window</td>
</tr>
<tr>
<td>TRAP_ADDRESS</td>
<td>TP</td>
<td>Sets a simulated I/O address</td>
</tr>
<tr>
<td>TRAP_ADDRESS_DISPLAY</td>
<td>TD</td>
<td>Displays simulated I/O address settings</td>
</tr>
<tr>
<td>TRAP_ADDRESS_ENABLE</td>
<td>TE</td>
<td>Enables or disables the simulated I/O</td>
</tr>
</tbody>
</table>
### 5.1.15 Utility

<table>
<thead>
<tr>
<th>Command Name</th>
<th>Abbreviation</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>HELP</td>
<td>HE</td>
<td>Displays the command line help</td>
</tr>
<tr>
<td>INITIALIZE</td>
<td>IN</td>
<td>Initializes the debugging platform</td>
</tr>
<tr>
<td>QUIT</td>
<td>QU</td>
<td>Exits HEW</td>
</tr>
<tr>
<td>RADIX</td>
<td>RA</td>
<td>Sets default input radix</td>
</tr>
<tr>
<td>RESPONSE</td>
<td>RP</td>
<td>Sets an interval to refresh the window</td>
</tr>
<tr>
<td>STATUS</td>
<td>STA</td>
<td>Displays the debugging platform status</td>
</tr>
<tr>
<td>TOOL_INFORMATION</td>
<td>TO</td>
<td>Outputs information on the currently registered tool to a file</td>
</tr>
</tbody>
</table>

### 5.1.16 Project/Workspace

<table>
<thead>
<tr>
<th>Command Name</th>
<th>Abbreviation</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADD_FILE</td>
<td>AF</td>
<td>Adds a file to the current project</td>
</tr>
<tr>
<td>CHANGE_CONFIGURATION</td>
<td>CC</td>
<td>Sets the current configuration</td>
</tr>
<tr>
<td>CHANGE_PROJECT</td>
<td>CP</td>
<td>Sets the current project</td>
</tr>
<tr>
<td>CHANGE_SESSION</td>
<td>CS</td>
<td>Changes the current session</td>
</tr>
<tr>
<td>CHANGE_SUB_SESSION</td>
<td>CB</td>
<td>Changes the currently active session when simultaneous debugging is enabled</td>
</tr>
<tr>
<td>CLEAR_OUTPUT_WINDOW</td>
<td>COW</td>
<td>Clears the contents of the specified tab in the [Output] window</td>
</tr>
<tr>
<td>CLOSE_WORKSPACE</td>
<td>CW</td>
<td>Close the current workspace</td>
</tr>
<tr>
<td>OPEN_WORKSPACE</td>
<td>OW</td>
<td>Opens a workspace</td>
</tr>
<tr>
<td>REFRESH_SESSION</td>
<td>RSE</td>
<td>Updates information on the session</td>
</tr>
<tr>
<td>REMOVE_FILE</td>
<td>REM</td>
<td>Removes a file from the current project</td>
</tr>
<tr>
<td>SAVE_SESSION</td>
<td>SE</td>
<td>Saves the current session</td>
</tr>
<tr>
<td>SAVE_WORKSPACE</td>
<td>SW</td>
<td>Saves the current workspace</td>
</tr>
<tr>
<td>UPDATE_ALL_DEPENDENCIES</td>
<td>UD</td>
<td>Updates all build dependencies of the current project</td>
</tr>
</tbody>
</table>
### 5.1.17 Test Tool Facility

<table>
<thead>
<tr>
<th>Command Name</th>
<th>Abbreviation</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>CLOSE_TEST</td>
<td>CT</td>
<td>Closes a test suite</td>
</tr>
<tr>
<td>COMPARE_TEST_DATA</td>
<td>CTD</td>
<td>Compares test data</td>
</tr>
<tr>
<td>LOAD_TEST_DATA</td>
<td>LTD</td>
<td>Loads test data to the [Load Test Image File] dialog box</td>
</tr>
<tr>
<td>OPEN_TEST</td>
<td>OT</td>
<td>Opens a test suite</td>
</tr>
<tr>
<td>RUN_TEST</td>
<td>RT</td>
<td>Executes a test</td>
</tr>
<tr>
<td>SAVE_TEST_DATA</td>
<td>STD</td>
<td>Saves test data</td>
</tr>
</tbody>
</table>
### 5.2 Commands (Alphabetical Order)

Table 5.1 lists the commands in alphabetical order.

Refer to the simulator/debugger help about each command.

#### Table 5.1 Simulator/Debugger Commands

<table>
<thead>
<tr>
<th>No.</th>
<th>Command Name</th>
<th>Abbreviation</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>!</td>
<td>-</td>
<td>Comment</td>
</tr>
<tr>
<td>2</td>
<td>ADD_FILE</td>
<td>AF</td>
<td>Adds a file to the current project</td>
</tr>
<tr>
<td>3</td>
<td>ANALYSIS</td>
<td>AN</td>
<td>Enables or disables performance analysis</td>
</tr>
<tr>
<td>4</td>
<td>ANALYSIS_RANGE</td>
<td>AR</td>
<td>Sets or displays performance analysis functions</td>
</tr>
<tr>
<td>5</td>
<td>ANALYSIS_RANGE_DELETE</td>
<td>AD</td>
<td>Deletes a performance analysis range</td>
</tr>
<tr>
<td>6</td>
<td>ASSEMBLE</td>
<td>AS</td>
<td>Assembles instructions into memory</td>
</tr>
<tr>
<td>7</td>
<td>ASSERT</td>
<td>-</td>
<td>Checks if an expression is true or false</td>
</tr>
<tr>
<td>8</td>
<td>AUTO_COMPLETE</td>
<td>AC</td>
<td>Enables or disables the auto-complete function</td>
</tr>
<tr>
<td>9</td>
<td>BREAKPOINT</td>
<td>BP</td>
<td>Sets a breakpoint at an instruction address</td>
</tr>
<tr>
<td>10</td>
<td>BREAK_ACCESS</td>
<td>BA</td>
<td>Specifies a memory range access as a break condition</td>
</tr>
<tr>
<td>11</td>
<td>BREAK_CLEAR</td>
<td>BC</td>
<td>Deletes breakpoints</td>
</tr>
<tr>
<td>12</td>
<td>BREAK_CYCLE</td>
<td>BCY</td>
<td>Specifies a cycle as a break condition</td>
</tr>
<tr>
<td>13</td>
<td>BREAK_DATA</td>
<td>BD</td>
<td>Specifies a memory data value as a break condition</td>
</tr>
<tr>
<td>14</td>
<td>BREAK_DATA_DIFFERENCE</td>
<td>BDD</td>
<td>Specifies a difference between two values of data in memory as a break condition</td>
</tr>
<tr>
<td>15</td>
<td>BREAK_DATA_INVERSE</td>
<td>BDI</td>
<td>Specifies inversion of the sign of a value of data in memory as a break condition</td>
</tr>
<tr>
<td>16</td>
<td>BREAK_DISPLAY</td>
<td>BI</td>
<td>Displays a list of breakpoints</td>
</tr>
<tr>
<td>17</td>
<td>BREAK_ENABLE</td>
<td>BE</td>
<td>Enables or disables a breakpoint</td>
</tr>
<tr>
<td>18</td>
<td>BREAK_REGISTER</td>
<td>BR</td>
<td>Specifies a register data as a break condition</td>
</tr>
<tr>
<td>19</td>
<td>BREAK_SEQUENCE</td>
<td>BS</td>
<td>Sets sequential breakpoints</td>
</tr>
<tr>
<td>20</td>
<td>BUILD</td>
<td>BU</td>
<td>Performs a build on the current project</td>
</tr>
<tr>
<td>21</td>
<td>BUILD_ALL</td>
<td>BL</td>
<td>Performs a build all on the current project</td>
</tr>
<tr>
<td>22</td>
<td>BUILD_FILE</td>
<td>BF</td>
<td>Compiles files</td>
</tr>
<tr>
<td>23</td>
<td>BUILD_MULTIPLE</td>
<td>BM</td>
<td>Builds multiple projects</td>
</tr>
</tbody>
</table>
### Table 5.1  Simulator/Debugger Commands (cont)

<table>
<thead>
<tr>
<th>No.</th>
<th>Command Name</th>
<th>Abbreviation</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>24</td>
<td>CACHE</td>
<td>-</td>
<td>Sets caching on or off</td>
</tr>
<tr>
<td>25</td>
<td>CHANGE_CONFIGURATION</td>
<td>CC</td>
<td>Sets the current configuration</td>
</tr>
<tr>
<td>26</td>
<td>CHANGE_PROJECT</td>
<td>CP</td>
<td>Sets the current project</td>
</tr>
<tr>
<td>27</td>
<td>CHANGE_SESSION</td>
<td>CS</td>
<td>Changes the current session</td>
</tr>
<tr>
<td>28</td>
<td>CHANGE_SUB_SESSION</td>
<td>CB</td>
<td>Changes the currently active session when</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>simultaneous debugging is enabled</td>
</tr>
<tr>
<td>29</td>
<td>CLEAN</td>
<td>CL</td>
<td>Deletes intermediate and output files produced in building</td>
</tr>
<tr>
<td>30</td>
<td>CLEAR_OUTPUT_WINDOW</td>
<td>COW</td>
<td>Clears the contents of the specified tab in the [Output] window</td>
</tr>
<tr>
<td>31</td>
<td>CLOSE_TEST</td>
<td>CT</td>
<td>Closes a test suite</td>
</tr>
<tr>
<td>32</td>
<td>CLOSE_WORKSPACE</td>
<td>CW</td>
<td>Close the current workspace</td>
</tr>
<tr>
<td>33</td>
<td>COMPARE_TEST_DATA</td>
<td>CTD</td>
<td>Compares test data</td>
</tr>
<tr>
<td>34</td>
<td>COVERAGE</td>
<td>CV</td>
<td>Enables or disables coverage measurement</td>
</tr>
<tr>
<td>35</td>
<td>COVERAGE_DISPLAY</td>
<td>CVD</td>
<td>Displays coverage information</td>
</tr>
<tr>
<td>36</td>
<td>COVERAGE_LOAD</td>
<td>CVL</td>
<td>Loads coverage information</td>
</tr>
<tr>
<td>37</td>
<td>COVERAGE_RANGE</td>
<td>CVR</td>
<td>Sets a coverage range</td>
</tr>
<tr>
<td>38</td>
<td>COVERAGE_SAVE</td>
<td>CVS</td>
<td>Saves coverage information</td>
</tr>
<tr>
<td>39</td>
<td>DEFAULT_OBJECT_FORMAT</td>
<td>DO</td>
<td>Sets the default object (program) format</td>
</tr>
<tr>
<td>40</td>
<td>DISASSEMBLE</td>
<td>DA</td>
<td>Disassembles memory contents</td>
</tr>
<tr>
<td>41</td>
<td>ERASE</td>
<td>ER</td>
<td>Clears the [Command Line] window</td>
</tr>
<tr>
<td>42</td>
<td>EVALUATE</td>
<td>EV</td>
<td>Evaluates an expression</td>
</tr>
<tr>
<td>43</td>
<td>EXEC_MODE</td>
<td>EM</td>
<td>Sets and displays execution mode</td>
</tr>
<tr>
<td>44</td>
<td>EXEC_STOP_SET</td>
<td>ESS</td>
<td>Sets or displays the execution mode at the occurrence of an interrupt</td>
</tr>
<tr>
<td>45</td>
<td>FILE_LOAD</td>
<td>FL</td>
<td>Loads an object (program) file</td>
</tr>
<tr>
<td>46</td>
<td>FILE_LOAD_ALL</td>
<td>LA</td>
<td>Loads all object (program) files</td>
</tr>
<tr>
<td>47</td>
<td>FILE_SAVE</td>
<td>FS</td>
<td>Saves memory to a file</td>
</tr>
</tbody>
</table>
Table 5.1  Simulator/Debugger Commands (cont)

<table>
<thead>
<tr>
<th>No.</th>
<th>Command Name</th>
<th>Abbreviation</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>48</td>
<td>FILE_UNLOAD</td>
<td>FU</td>
<td>Unloads an object (program) file from memory</td>
</tr>
<tr>
<td>49</td>
<td>FILE_UNLOAD_ALL</td>
<td>UA</td>
<td>Unloads all object (program) files from memory</td>
</tr>
<tr>
<td>50</td>
<td>FILE_VERIFY</td>
<td>FV</td>
<td>Verifies file contents against memory</td>
</tr>
<tr>
<td>51</td>
<td>GENERATE_MAKE_FILE</td>
<td>GM</td>
<td>Generates a build makefile for the current workspace</td>
</tr>
<tr>
<td>52</td>
<td>GO</td>
<td>GO</td>
<td>Executes user program</td>
</tr>
<tr>
<td>53</td>
<td>GO_RESET</td>
<td>GR</td>
<td>Executes user program from reset vector</td>
</tr>
<tr>
<td>54</td>
<td>GO_TILL</td>
<td>GT</td>
<td>Executes user program until temporary breakpoint</td>
</tr>
<tr>
<td>55</td>
<td>HALT</td>
<td>HA</td>
<td>Halts the user program</td>
</tr>
<tr>
<td>56</td>
<td>HELP</td>
<td>HE</td>
<td>Displays the command line help</td>
</tr>
<tr>
<td>57</td>
<td>INITIALIZE</td>
<td>IN</td>
<td>Initializes the debugging platform</td>
</tr>
<tr>
<td>58</td>
<td>LOG</td>
<td>LO</td>
<td>Controls command output logging</td>
</tr>
<tr>
<td>59</td>
<td>MAP_DISPLAY</td>
<td>MA</td>
<td>Displays memory resource settings</td>
</tr>
<tr>
<td>60</td>
<td>MAP_SET</td>
<td>MS</td>
<td>Allocates a memory area</td>
</tr>
<tr>
<td>61</td>
<td>MEMORY_COMPARE</td>
<td>MC</td>
<td>Compares memory contents</td>
</tr>
<tr>
<td>62</td>
<td>MEMORY_DISPLAY</td>
<td>MD</td>
<td>Displays memory contents</td>
</tr>
<tr>
<td>63</td>
<td>MEMORY_EDIT</td>
<td>ME</td>
<td>Modifies memory contents</td>
</tr>
<tr>
<td>64</td>
<td>MEMORY_FILL</td>
<td>MF</td>
<td>Modifies the content of a memory area by specifying</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>data</td>
</tr>
<tr>
<td>65</td>
<td>MEMORY_FIND</td>
<td>MI</td>
<td>Finds a string in an area of memory</td>
</tr>
<tr>
<td>66</td>
<td>MEMORY_MOVE</td>
<td>MV</td>
<td>Moves a block of memory</td>
</tr>
<tr>
<td>67</td>
<td>MEMORY_TEST</td>
<td>MT</td>
<td>Tests a block of memory</td>
</tr>
<tr>
<td>68</td>
<td>OPEN_TEST</td>
<td>OT</td>
<td>Opens a test suite</td>
</tr>
<tr>
<td>69</td>
<td>OPEN_WORKSPACE</td>
<td>OW</td>
<td>Opens a workspace</td>
</tr>
<tr>
<td>70</td>
<td>PROFILE</td>
<td>PR</td>
<td>Enables or disables profile</td>
</tr>
<tr>
<td>71</td>
<td>PROFILE_DISPLAY</td>
<td>PD</td>
<td>Displays profile information</td>
</tr>
<tr>
<td>72</td>
<td>PROFILE_SAVE</td>
<td>PS</td>
<td>Saves the profile information to file</td>
</tr>
<tr>
<td>73</td>
<td>QUIT</td>
<td>QU</td>
<td>Exits HEW</td>
</tr>
<tr>
<td>74</td>
<td>RADIX</td>
<td>RA</td>
<td>Sets default input radix</td>
</tr>
<tr>
<td>75</td>
<td>REFRESH_SESSION</td>
<td>RSE</td>
<td>Updates information on the session</td>
</tr>
<tr>
<td>No.</td>
<td>Command Name</td>
<td>Abbreviation</td>
<td>Function</td>
</tr>
<tr>
<td>-----</td>
<td>----------------------------------</td>
<td>--------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>76</td>
<td>REGISTER_DISPLAY</td>
<td>RD</td>
<td>Displays CPU register values</td>
</tr>
<tr>
<td>77</td>
<td>REGISTER_SET</td>
<td>RS</td>
<td>Changes CPU register contents</td>
</tr>
<tr>
<td>78</td>
<td>REMOVE_FILE</td>
<td>REM</td>
<td>Removes a file from the current project</td>
</tr>
<tr>
<td>79</td>
<td>RESET</td>
<td>RE</td>
<td>Resets CPU</td>
</tr>
<tr>
<td>80</td>
<td>RESPONSE</td>
<td>RP</td>
<td>Sets an interval to refresh the window</td>
</tr>
<tr>
<td>81</td>
<td>RUN_TEST</td>
<td>RT</td>
<td>Executes a test</td>
</tr>
<tr>
<td>82</td>
<td>SLEEP</td>
<td>-</td>
<td>Delays command execution</td>
</tr>
<tr>
<td>83</td>
<td>SAVE_SESSION</td>
<td>SE</td>
<td>Saves the current session</td>
</tr>
<tr>
<td>84</td>
<td>SAVE_WORKSPACE</td>
<td>SW</td>
<td>Saves the current workspace</td>
</tr>
<tr>
<td>85</td>
<td>SET_DISASSEMBLY_SOFT_BREAK</td>
<td>SDB</td>
<td>Sets or deletes a software breakpoint at the disassembly level</td>
</tr>
<tr>
<td>86</td>
<td>SET_SOURCE_SOFT_BREAK</td>
<td>SSB</td>
<td>Sets or deletes a software breakpoint at the source level</td>
</tr>
<tr>
<td>87</td>
<td>SIMULATEDIO_CLEAR</td>
<td>SIOC</td>
<td>Clears the contents of the [Simulated I/O] window</td>
</tr>
<tr>
<td>88</td>
<td>STATE_DISASSEMBLY_SOFT_BREAK</td>
<td>TDB</td>
<td>Enables or disables a software breakpoint at the disassembly level</td>
</tr>
<tr>
<td>89</td>
<td>STATE_SOURCE_SOFT_BREAK</td>
<td>TSB</td>
<td>Enables or disables a software breakpoint at the source level</td>
</tr>
<tr>
<td>90</td>
<td>STATUS</td>
<td>STA</td>
<td>Displays the debugging platform status</td>
</tr>
<tr>
<td>91</td>
<td>STEP</td>
<td>ST</td>
<td>Steps program (by instructions or source lines)</td>
</tr>
<tr>
<td>92</td>
<td>STEP_MODE</td>
<td>SM</td>
<td>Selects the step mode</td>
</tr>
<tr>
<td>93</td>
<td>STEP_OUT</td>
<td>SP</td>
<td>Steps out of the current function</td>
</tr>
<tr>
<td>94</td>
<td>STEP_OVER</td>
<td>SO</td>
<td>Steps program, not stepping into functions</td>
</tr>
<tr>
<td>95</td>
<td>STEP_RATE</td>
<td>SR</td>
<td>Sets or displays rate of stepping</td>
</tr>
<tr>
<td>96</td>
<td>SUBMIT</td>
<td>SU</td>
<td>Executes a command file</td>
</tr>
<tr>
<td>97</td>
<td>SYMBOL_ADD</td>
<td>SA</td>
<td>Defines a symbol</td>
</tr>
<tr>
<td>98</td>
<td>SYMBOL_CLEAR</td>
<td>SC</td>
<td>Deletes a symbol</td>
</tr>
<tr>
<td>99</td>
<td>SYMBOL_LOAD</td>
<td>SL</td>
<td>Loads a symbol information file</td>
</tr>
<tr>
<td>100</td>
<td>SYMBOL_SAVE</td>
<td>SS</td>
<td>Saves a symbol information file</td>
</tr>
<tr>
<td>101</td>
<td>SYMBOL_VIEW</td>
<td>SV</td>
<td>Displays symbols</td>
</tr>
</tbody>
</table>
Table 5.1 Simulator/Debugger Commands (cont)

<table>
<thead>
<tr>
<th>No.</th>
<th>Command Name</th>
<th>Abbreviation</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>102</td>
<td>TCL</td>
<td>-</td>
<td>Enables or disables the TCL</td>
</tr>
<tr>
<td>103</td>
<td>TOOL_INFORMATION</td>
<td>TO</td>
<td>Outputs information on the currently registered tool to a file</td>
</tr>
<tr>
<td>104</td>
<td>TRACE</td>
<td>TR</td>
<td>Displays trace information</td>
</tr>
<tr>
<td>105</td>
<td>TRACE_ACQUISITION</td>
<td>TA</td>
<td>Enables or disables trace information acquisition</td>
</tr>
<tr>
<td>106</td>
<td>TRACE_SAVE</td>
<td>TV</td>
<td>Outputs trace information into a file</td>
</tr>
<tr>
<td>107</td>
<td>TRACE_STATISTIC</td>
<td>TST</td>
<td>Analyzes statistic information</td>
</tr>
<tr>
<td>108</td>
<td>TRAP_ADDRESS</td>
<td>TP</td>
<td>Sets a simulated I/O address</td>
</tr>
<tr>
<td>109</td>
<td>TRAP_ADDRESS_DISPLAY</td>
<td>TD</td>
<td>Displays simulated I/O address settings</td>
</tr>
<tr>
<td>110</td>
<td>TRAP_ADDRESS_ENABLE</td>
<td>TE</td>
<td>Enables or disables the simulated I/O</td>
</tr>
<tr>
<td>111</td>
<td>UPDATE_ALL_DEPENDENCIES</td>
<td>UD</td>
<td>Updates all build dependencies of the current project</td>
</tr>
<tr>
<td>112</td>
<td>WATCH_ADD</td>
<td>WA</td>
<td>Adds an item for watching</td>
</tr>
<tr>
<td>113</td>
<td>WATCH_AUTO_UPDATE</td>
<td>WU</td>
<td>Selects or cancels automatic updating of watched items</td>
</tr>
<tr>
<td>114</td>
<td>WATCH_DELETE</td>
<td>WD</td>
<td>Deletes a watched item</td>
</tr>
<tr>
<td>115</td>
<td>WATCH_DISPLAY</td>
<td>WI</td>
<td>Displays the contents of the Watch window</td>
</tr>
<tr>
<td>116</td>
<td>WATCH_EDIT</td>
<td>WE</td>
<td>Edits the value of a watched item</td>
</tr>
<tr>
<td>117</td>
<td>WATCH_EXPAND</td>
<td>WX</td>
<td>Expands or collapses a watched item</td>
</tr>
<tr>
<td>118</td>
<td>WATCH_RADIX</td>
<td>WR</td>
<td>Changes the radix for display of watched items</td>
</tr>
<tr>
<td>119</td>
<td>WATCH_RECORD</td>
<td>WO</td>
<td>Outputs the history of updating of the values of a watched item to a file</td>
</tr>
<tr>
<td>120</td>
<td>WATCH_SAVE</td>
<td>WS</td>
<td>Saves the contents of the Watch window to a file</td>
</tr>
</tbody>
</table>

Refer to the simulator/debugger help about each command.
Section 6   Messages

6.1   Information Messages

The simulator/debugger outputs information messages as listed in table 6.1 to notify users of execution status.

Table 6.1   Information Messages

<table>
<thead>
<tr>
<th>Message</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Break Access</td>
<td>An access break condition was satisfied so execution has stopped. The information in parentheses shows the satisfied access break condition (accessed address, access type, and access unit).</td>
</tr>
<tr>
<td>(Access Address: H'n'nnnnnnn, Type: xxxx, Access Size: yyyy)</td>
<td></td>
</tr>
<tr>
<td>Break Cycle</td>
<td>A number-of-cycles condition was satisfied so execution has stopped. The information in parentheses shows the satisfied number-of-cycles condition (number of cycles).</td>
</tr>
<tr>
<td>(Cycle: H'n'nnnnnnn)</td>
<td></td>
</tr>
<tr>
<td>Break Data</td>
<td>A data break condition ([Equal] or [Not equal]) was satisfied so execution has stopped. The information in parentheses shows the satisfied data break condition (accessed address and value).</td>
</tr>
<tr>
<td>(Access Address: H'n'nnnnnnn, Data: H'm'nnnnnnnnnn)</td>
<td></td>
</tr>
<tr>
<td>Break Data</td>
<td>A data break condition ([Inverse sign] or [Difference]) was satisfied so execution has stopped. The information in parentheses shows the satisfied data break condition (accessed address, and previous and current values).</td>
</tr>
<tr>
<td>(Access Address: H'n'nnnnnnn, Previous Data: H'm'nnnnnnnnn, Current Data: H'm'nnnnnnnnn)</td>
<td></td>
</tr>
<tr>
<td>Break Register</td>
<td>A register break condition was satisfied so execution has stopped. The information in parentheses shows the satisfied register break condition (register name and value).</td>
</tr>
<tr>
<td>(Register: XX, Value: H'm'nnnnnnnnnnn)</td>
<td></td>
</tr>
<tr>
<td>Break Sequence</td>
<td>A sequential break condition was satisfied so execution has stopped. The information in parentheses shows the satisfied sequential break condition (address of the last instruction).</td>
</tr>
<tr>
<td>(PC: H'n'nnnnnnn)</td>
<td></td>
</tr>
<tr>
<td>I/O DLL Stop</td>
<td>The peripheral function has stopped.</td>
</tr>
<tr>
<td>PC Breakpoint</td>
<td>A PC breakpoint condition was satisfied so execution has stopped. The information in parentheses shows the satisfied PC-breakpoint condition (instruction address).</td>
</tr>
<tr>
<td>(PC: H'n'nnnnnnn)</td>
<td></td>
</tr>
<tr>
<td>Sleep</td>
<td>Execution has been stopped by the SLEEP instruction.</td>
</tr>
<tr>
<td>Step Normal End</td>
<td>The step execution succeeded.</td>
</tr>
</tbody>
</table>
Table 6.1 Information Messages (cont)

<table>
<thead>
<tr>
<th>Message</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stop</td>
<td>Execution has been stopped by the [Stop] button.</td>
</tr>
<tr>
<td>Trace Buffer Full</td>
<td>Since the Break mode was selected by [Trace buffer full handling] in the</td>
</tr>
<tr>
<td></td>
<td>[Trace Acquisition] dialog box and the trace buffer became full, execution</td>
</tr>
<tr>
<td></td>
<td>was terminated.</td>
</tr>
</tbody>
</table>

6.2 Error Messages

The simulator/debugger outputs error messages to notify users of the errors of user programs or operation. Table 6.2 lists the error messages.

Table 6.2 Error Messages

<table>
<thead>
<tr>
<th>Message</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address Error</td>
<td>One of the following states occurred:</td>
</tr>
<tr>
<td></td>
<td>• The PC value was an odd number.</td>
</tr>
<tr>
<td></td>
<td>• An instruction was read from the internal I/O area.</td>
</tr>
<tr>
<td></td>
<td>• Word data was accessed to an address that was not a multiple of 2.</td>
</tr>
<tr>
<td></td>
<td>• Longword data was accessed to an address that was not a multiple of 2.</td>
</tr>
<tr>
<td></td>
<td>Correct the user program to prevent the error.</td>
</tr>
<tr>
<td>Exception Error</td>
<td>An error occurred during exception processing.</td>
</tr>
<tr>
<td></td>
<td>Correct the user program to prevent the error.</td>
</tr>
<tr>
<td>File Open Error</td>
<td>An error occurred during opening a file with the file-input/output action</td>
</tr>
<tr>
<td></td>
<td>of Break. Correct the file setting.</td>
</tr>
<tr>
<td>File Input Error</td>
<td>An error occurred during reading a file with the file-input/output action</td>
</tr>
<tr>
<td></td>
<td>of Break. Correct the file setting.</td>
</tr>
<tr>
<td>File Output Error</td>
<td>An error occurred during writing to a file with the file-input/output</td>
</tr>
<tr>
<td></td>
<td>action of Break. Correct the file setting.</td>
</tr>
<tr>
<td>Illegal Instruction</td>
<td>Either of the following states occurred:</td>
</tr>
<tr>
<td></td>
<td>• A code other than an instruction was executed.</td>
</tr>
<tr>
<td></td>
<td>• MOV.B Rn, @-SP or MOV.B @SP+, Rn was executed.</td>
</tr>
<tr>
<td></td>
<td>Correct the user program to prevent the error.</td>
</tr>
</tbody>
</table>
### Error Messages (cont)

<table>
<thead>
<tr>
<th>Message</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Illegal Operation</td>
<td>Either of the following states occurred:</td>
</tr>
<tr>
<td></td>
<td>• The relationship between flags C and H of CCR and the value before correction was illegal in the DAA or DAS instruction.</td>
</tr>
<tr>
<td></td>
<td>• A division by zero or an overflow occurred during DIVXU or DIVXS instruction execution.</td>
</tr>
<tr>
<td></td>
<td>Correct the user program to prevent the error.</td>
</tr>
<tr>
<td>I/O area not exist</td>
<td>An attempt was made to delete the I/O area. Be sure to set the I/O area.</td>
</tr>
<tr>
<td>I/O DLL Illegal Interrupt</td>
<td>Information on interrupts is incorrect. [errNum] shows the details on this error. Correct the information.</td>
</tr>
<tr>
<td>Information (errNum=2xx)</td>
<td>[errNum]</td>
</tr>
<tr>
<td></td>
<td>200: The specified vector is outside the supported range.</td>
</tr>
<tr>
<td></td>
<td>201: The specified priority is outside the supported range.</td>
</tr>
<tr>
<td>I/O DLL Memory Access Error</td>
<td>An error has occurred during a memory access to the peripheral function. [errNum] shows the details on this error and [Address] shows the address where this error occurred. Correct the user program according to the error information.</td>
</tr>
<tr>
<td>(errNum=0xx, Address=0xXXXXXXXX)</td>
<td>[errNum]</td>
</tr>
<tr>
<td></td>
<td>001: The specified address is outside the supported range.</td>
</tr>
<tr>
<td></td>
<td>002: No memory exists in the specified area.</td>
</tr>
<tr>
<td></td>
<td>003: The required memory cannot be allocated.</td>
</tr>
<tr>
<td></td>
<td>004: The specified data size is outside the supported range.</td>
</tr>
<tr>
<td></td>
<td>005: The specified address cannot be accessed.</td>
</tr>
<tr>
<td>I/O DLL Register Access Error</td>
<td>An error has occurred during a register access to the peripheral function. [errNum] shows the details on this error and [RegisterName] shows the register where this error occurred. Correct the user program according to the error information.</td>
</tr>
<tr>
<td>(errNum=1xx, RegisterName=xxxx)</td>
<td>[errNum]</td>
</tr>
<tr>
<td></td>
<td>100: The register description is incorrect.</td>
</tr>
<tr>
<td></td>
<td>101: The specified data value is incorrect.</td>
</tr>
</tbody>
</table>
### Table 6.2 Error Messages (cont)

<table>
<thead>
<tr>
<th>Message</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory Access Error</td>
<td>One of the following events occurred (the information in parentheses shows the target address for the operation that generated the error):</td>
</tr>
<tr>
<td>(Address: H'nnnnnnnn)</td>
<td>• A memory area that had not been allocated was accessed.</td>
</tr>
<tr>
<td></td>
<td>• Data was written to a memory area having the write-protected attribute.</td>
</tr>
<tr>
<td></td>
<td>• Data was read from a memory area having the read-disabled attribute.</td>
</tr>
<tr>
<td></td>
<td>• A memory area in which memory does not exist was accessed.</td>
</tr>
<tr>
<td></td>
<td>• Writing to the EEPROM was attempted by instructions other than EEPMOV</td>
</tr>
<tr>
<td></td>
<td>Allocate memory, change the memory attribute, or correct the user program to prevent the memory from being accessed.</td>
</tr>
<tr>
<td>System Call Error</td>
<td>Simulated I/O error occurred. Modify the incorrect contents of registers R0, R1, and parameter block.</td>
</tr>
<tr>
<td>The memory resource has not been set up</td>
<td>The memory resource was set outside the range of memory mapping. Modify the memory resource settings so that no error will occur.</td>
</tr>
</tbody>
</table>
7.1 Preparation

The basic functions of the simulator/debugger will be described in this section using a sample program.

Note: The contents of usage examples (figures) in this section will differ depending on the compiler version.

7.1.1 Sample Program

The HEW demonstration program is used for the sample program and is written in C language. It first sorts ten random data in the ascending order, and then in the descending order. The sample program:

(1) Generates random data for sorting using the main function.
(2) Inputs the array which stores the random data that is generated by the main function, then sorts the data in the ascending order using the sort function.
(3) Inputs the array generated by the sort function, and sorts the data in the descending order using the change function.
(4) Displays the random data and the sorted data using the printf function.

The HEW demonstration program is used as the sample program.

7.1.2 Creating the Sample Program

Note the following when creating the HEW demonstration program:

- Specify [Demonstration] for [Project Type] in [Creating a New Workspace].
- Specify [2600] for [CPU Series:].
- Specify [H8S/2600N Simulator] for [Target:].
- Specify [SimDebug_H8S-2600] for the configuration on the toolbar before building the project.
- Specify [SimSessionH8S-2600] for the session on the toolbar.
- This demonstration program uses no peripheral function (timer). In the [Set Peripheral Function Simulation] dialog box that opens when the session is changed, check [Don’t show this dialog box] and then press the [OK] button.
Since this section explains the debugging function, [Demonstration] has not been optimized. Do not change this setting.

7.2 Settings for Debugging

7.2.1 Allocating the Memory Resource

The allocation of the memory resource is necessary to run the application being developed. When using the demonstration project, the memory resource is allocated automatically, so check the setting.

- Select [Simulator->Memory Resource...] from the [Setup] menu, and display the allocation of the current memory resource.

![Simulator System Dialog Box (Memory Page)](image)

**Figure 7.1** Simulator System Dialog Box (Memory Page)
The program and stack areas are allocated to the range of addresses H'00000000 to H'0000FFFF, which can be read from or written to.

- Close the dialog box by clicking [OK].

The memory resource can also be referred to or modified by using the [Debugger] page on the [H8S, H8/300 Standard Toolchain] dialog box. Changes made in either of the dialog boxes are reflected.
7.2.2 Downloading the Sample Program

When using the demonstration project, the sample program to be downloaded is automatically set, so check the settings.

- Open the [Debug Setting] dialog box by selecting [Debug Settings...] on the [Debug] menu.

![Debug Settings Dialog Box]

- Files to be downloaded are listed in [Download Modules].
- Close the [Debug Settings] dialog box by clicking the [OK] button.
- Download the sample program by selecting [Download Modules->All Download Modules] from the [Debug] menu.
7.2.3 Displaying the Source Program

The HEW supports the source-level debugging. Display the source file ("Tutorial.c") in the [Source] window.

- Open the [Source] window by double-clicking Tutorial.c on the [Workspace] window.

```c
void main(void)
{
    long a[10], min, max;
    long j;
    int i;

    srand(1);
    printf("### Data Input ###n");

    for (i=0; i<10; i++)
    {
        j = rand();
        if(j < 0){
            j = -j;
        }
        a[i] = j;
        printf(a[10]=%ld%n,i,a[i]);
    }

    sort(a);
    printf("### Sorting results ###n");
    for (i=0; i<10; i++)
    { printf(a[10]=%ld%n,i,a[i]);
    }

    min = a[0];
    max = a[0];
    min = 0;
    max = 0;
    change(a);
    min = a[3];
    max = a[3];
```

Figure 7.3 Source Window (Displaying the Source Program)
### 7.2.4 Setting a PC Breakpoint

Breakpoints can be set easily via the [Source] window. To set a breakpoint on a line that includes the sort function call:

- Place the cursor in the line that includes the sort function call and click the right mouse button to launch the pop-up menu, and select [Toggle Breakpoint] from the pop-up menu.

```
void main(void)
{
    long a[10], min, max;
    long i;
    int j;
    srand(1);
    printf("### Data Input ###\n");
    for (i=0; i<10; i++)
    {
        j = rand();
        if (j < 0)
        {
            j = -j;
        }
        a[i] = j;
        printf("a[%d]=%d\n",i,a[i]);
    }
    sort(a);
    printf("### Sorting results ###\n");
    for (i=0; i<10; i++)
    {
        printf("a[%d]=%d\n",i,a[i]);
    }
    min = a[0];
    max = a[0];
    min = 0;
    max = 0;
    change(a);
    min = a[3];
    max = a[3];
}
```

**Figure 7.4 Source Window (Setting the Breakpoint)**
A [•] is displayed at the line that includes the sort function call, indicating that the PC breakpoint is set at the address.

7.2.5 Setting the Profiler

- Open the [Profile] window by selecting [Profile] from the [View->Performance] menu.

![Figure 7.5 Profile Window](image)

- Open the pop-up menu by right clicking the mouse on the [Profile] window, and select [Enable Profiler] to enable acquisition of the profile information.
7.2.6 Setting the Simulated I/O

When the demonstration project is used, the simulated I/O is automatically set, so check the setting.

- Open the [Simulator System] dialog box by selecting [Simulator->System] from the [Setup] menu.

![Simulator System Dialog Box (System Page)](image)

- Confirm that [Enable] in [Simulated I/O Address] is checked.
- Click the [OK] button to enable the simulated I/O.
- Select [Simulated I/O] from the [View->CPU] menu and open the [Simulated I/O] window. The simulated I/O will not be enabled if the [Simulated I/O] window is not open.
Figure 7.7  Simulated I/O Window
7.2.7 Setting the Trace Information Acquisition Conditions

- Select [Trace] from the [View→Code] menu to open the [Trace] window. Open the pop-up menu by right clicking the mouse on the [Trace] window, and select [Acquisition...] from the pop-up menu.

The [Trace Acquisition] dialog box below will be displayed.

![Trace Acquisition Dialog Box](image)

**Figure 7.8 Trace Acquisition Dialog Box**

- Set [Trace Start/Stop] to [Enable] in the [Trace Acquisition] dialog box, and click the [OK] button to enable the acquisition of the trace information.
7.2.8 Setting the Stack Pointer and Program Counter

To execute the program, the program counter must be set from the location of the reset vector. In the reset vector of the sample program, the PC value H'400 is written.

- Select [Reset CPU] from the [Debug] menu, or click the [Reset CPU] button on the toolbar.

Set the program counter to H'400 from the reset vector.

![Reset CPU Button](image)

Figure 7.9 Reset CPU Button

7.3 Start Debugging

7.3.1 Executing a Program

- Select [Go] from the [Debug] menu, or click the [Go] button on the toolbar.

![Go Button](image)

Figure 7.10 Go Button

The program halts where a breakpoint is set. An arrow is displayed in the [Source] window, indicating the location the execution has stopped. As the termination cause, [PC Breakpoint (PC: H’0B36)] is displayed in the [Output] window.
The termination cause can be displayed in the [Status] window.

The above status window indicates that:

1. The cause of break is a PC breakpoint
2. Execution is performed from the reset
3. The number of executed instructions by the GO command is 39,580
4. The executed number of cycles from the reset is 278,634
Register values can be checked in the [Register] window.

- Select [Registers] from the [View->CPU] menu.

![Register Window](image)

**Figure 7.13  Register Window**

Register values when the program is terminated can be checked.
7.3.2 Using the Trace Buffer

The trace buffer can be used to clarify the history of instruction execution.

- Select [Trace] from the [View->Code] menu and open the [Trace] window. Scroll up to the very top of the window.

![Figure 7.14 Trace Window (Trace Information Display)](image-url)
7.3.3 Performing Trace Search

Click the right mouse button on the [Trace] window to launch the pop-up menu, and select [Find...] to open the [Trace Search] dialog box.

Setting the item to be searched to [Item] and the contents to be searched to [Value] and clicking the [OK] button begins the trace search. When the searched item is found, the first line is highlighted. To continue searching the same contents [Value], click the right mouse button in the [Trace] window to display the pop-up menu, and select [Find Next] from the pop-up menu. The next searched line is highlighted.
7.3.4 Checking Simulated I/O

Random data that is displayed by the printf function can be checked in the [Simulated I/O] window.
• Do not close the [Simulated I/O] window.

### 7.3.5 Checking the Breakpoints

A list of all the breakpoints that are set in the program can be checked in the [Event] window.

• Select [Eventpoints] from the [View -> Code] menu.

![Figure 7.18 Event Window](image)

A breakpoint can be set, a new breakpoint can be defined, and a breakpoint can be deleted using the [Event] window.

• Close the [Event] window.

### 7.3.6 Watching Variables

It is possible to watch the values of variables used in your program and to verify that they change in the way that you expected. For example, set a watch on the long-type array “a” declared at the beginning of the program, by using the following procedure:

• Select [Watch] from the [View -> Symbol] menu to open the [Watch] window. And click the right mouse button on the [Watch] window and choose [Add Watch...] from the pop-up menu.

The following dialog box will be displayed.
Type array “a” and click the [OK] button.

The [Watch] window will show the long-type array “a”. You can double-click the + symbol to the left of array “a” in the [Watch] window to expand the variable and show the individual elements in the array.

Close the [Watch] window.
7.3.7 Executing the Program in Single Steps

The simulator/debugger has various stepping menus that are useful in debugging the program.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step In</td>
<td>Executes each statement (includes statements within the function)</td>
</tr>
<tr>
<td>Step Over</td>
<td>Executes a function call in a single step</td>
</tr>
<tr>
<td>Step Out</td>
<td>Steps out of a function, and stops at the next statement of the program that called the function</td>
</tr>
<tr>
<td>Step...</td>
<td>Executes the specified number of steps at the specified speed</td>
</tr>
</tbody>
</table>

[Step In]: Enters the called function and stops at the statement at the start of the called function.

- To step in the sort function, select [Step In] from the [Debug] menu, or click the [Step In] button on the toolbar.

Figure 7.21 Step In Button
Figure 7.22  Source Window (Step In)

- The PC location display (=>) in the [Source] window moves to the statement at the start of the sort function.
[Step Out]: Steps out of the called function and stops at the next statement in the called program.

- Select [Step Out] from the [Debug] menu to exit the sort function, or click the [Step Out] button on the toolbar.

Figure 7.23  Step Out Button
Figure 7.24 Source Window (Step Out)
[Step Over]: Executes a function call in a single step, and stops at the next statement in the main program.

Select [Step Over] from the [Debug] menu or click the [Step Over] button on the toolbar to step over the statements in the printf function.

Figure 7.25   Step Over Button
When the `printf` function has been executed, *** Sorting results *** will be displayed in the [Simulated I/O] window.
7.3.8 Checking Profile Information

The profile information can be checked in the [Profile] window.

- Clicking the [Go] button and continuing execution from the current PC executes the SLEEP instruction and then stops.

[List] Sheet: Displays the profile information as a list.

- Open the [Profile] window by selecting [Profile] from the [View->Performance] menu. The [List] sheet will be displayed.

![Figure 7.27 Profile Window (List Sheet)](image)

In the above figure, it can be found that the __flclose function was called six times, the execution cycle was 1107, and the internal memory was accessed 69 times.

It is possible to search for the critical path, such as a function that is called or accesses the memory many times, for the program performance.
**Tree Sheet**: Displays the profile information as a tree diagram.

- Select the [Tree] sheet. Double-clicking the function name in the [Profile] window expands or minimizes the tree structure.

![Figure 7.28 Profile Window (Tree Sheet)](image)

In above figure, it can be found that the `__fclose` function was called three times from the `_fclose` function, the execution cycle was 762, and the internal memory was accessed 48 times.
[Profile-Chart] Window: Displays the relation of calls for a specific function.

- Select the __flclose function on the [Profile] window. Open the pop-up menu by right clicking the mouse on the [Profile] window, and select [View Profile-Chart] to display the [Profile-Chart] window.

![Profile-Chart Window](image)

In the above figure, it can be found that the __flclose function was called three times from the fclose and freopen functions, and the _close function was called three times.

This is the end of the tutorial using the simulator/debugger.

Renesas Technology America, Inc.
450 Holger Way, San Jose, CA 95134-1368, U.S.A
Tel: <1> (408) 382-7500, Fax: <1> (408) 382-7501

Renesas Technology Europe Limited
Dukes Meadow, Millboard Road, Bourne End, Buckinghamshire, SL8 5FH, U.K.
Tel: <44> (1628) 585-100, Fax: <44> (1628) 585-900

Renesas Technology (Shanghai) Co., Ltd.
Unit 204, 205 AZACenter, No.1233 Lujiazui Ring Rd, Pudong District, Shanghai, China 200120
Tel: <86> (21) 5877-1818, Fax: <86> (21) 6887-7898

Renesas Technology Hong Kong Ltd.
7th Floor, North Tower, World Finance Centre, Harbour City, 1 Canton Road, Tsimshatsui, Kowloon, Hong Kong
Tel: <852> 2215-6688, Fax: <852> 2730-6071

Renesas Technology Taiwan Co., Ltd.
10th Floor, No.99, Fushing North Road, Taipei, Taiwan
Tel: <886> (2) 2715-2888, Fax: <886> (2) 2713-2999

Renesas Technology Singapore Pte. Ltd.
1 Harbour Front Avenue, #6-10, Keppel Bay Tower, Singapore 098632
Tel: <65> 6213-0200, Fax: <65> 6278-8001

Renesas Technology Korea Co., Ltd.
Kukje Center Bldg. 18th Fl,. 191, 2-ka, Hangang-ro, Yongsan-ku, Seoul 140-702, Korea
Tel: <82> (2) 796-3115, Fax: <82> (2) 796-2145

Renesas Technology Malaysia Sdn. Bhd
Unit 906, Block B, Menara Amcorp. Amcorp Trade Centre, No.18, Jalan Persiaran Barat, 46050 Petaling Jaya, Selangor Darul Ehsan, Malaysia
Tel: <603> 7955-9390, Fax: <603> 7955-9510
H8S, H8/300 Series Simulator/Debugger
User’s Manual